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Safety warning notice

Å
WARNING: To reduce the possibility of heat-related injuries or of overheating the computer, do not place the computer directly 
on your lap or obstruct the computer air vents. Use the computer only on a hard, flat surface. Do not allow another hard surface, 
such as an adjoining optional printer, or a soft surface, such as pillows or rugs or clothing, to block airflow. Also, do not allow 
the AC adapter to contact the skin or a soft surface, such as pillows or rugs or clothing, during operation. The computer and the 
AC adapter comply with the user-accessible surface temperature limits defined by the International Standard for Safety of 
Information Technology Equipment (IEC 60950).
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1
Product description

Category Description

Product Name HP EliteBook 2730p Notebook PC

Processors Intel® Core™2 Duo ultra low-voltage, non-socketed processors:

■ SL9600 2.13-GHz processor, 6-MB L2 cache, 1066-MHz front side bus (FSB)

■ SL9400 1.86-GHz processor, 6-MB L2 cache, 1066-MHz FSB

■ SL9300 1.60-GHz processor, 6-MB L2 cache, 1066-MHz FSB

■ SU9400 1.40-GHz processor, 3-MB L2 cache, 800-MHz FSB

■ SU9300 1.20-GHz processor, 3-MB L2 cache, 800-MHz FSB

Chipset Northbridge: Cantiga GS
Southbridge: Intel ICH9M SFF enhanced

Graphics Intel Graphics Media Accelerator X4500 HD Unified Memory Architecture (UMA) graphics 
subsystem integrated with shared system memory (dynamically allocated) with up to 384 MB 
shared system memory

Panel Digitizer with pen support
Sparkle-free glass
Integrated keyboard light
2 wireless local area network (WLAN) antennae

Supports the following display assemblies:

■ 12.1-inch WXGA LED AntiGlare (1280 × 800) with webcam and outdoor light

■ 12.1-inch WXGA LED AntiGlare (1280 × 800) with webcam

■ 12.1-inch WXGA LED AntiGlare (1280 × 800) with outdoor light

■ 12.1-inch WXGA LED AntiGlare (1280 × 800)

Memory 2 customer-accessible/upgradable memory module slots
Supports dual-channel memory
Supports PC2-6400, 800-MHz, DDR2 memory modules
Up to 8192-GB maximum memory supported

Supports the following configurations: 

■ 8192-MB total system memory (4096 × 2, dual-channel)

■ 6144-MB total system memory (4096 + 2048)

■ 5120-MB total system memory (4096 + 1024)

■ 4096-MB total system memory (2048 × 2, dual-channel)

■ 3072-MB total system memory (2048 + 1024)

■ 2048-MB total system memory (1024 × 2, dual-channel)

■ 2048-MB total system memory (2048 × 1) 

■ 1024-MB total system memory (1024 × 1) 

(Continued)
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Product description
Mass storage drives Supports 45.72-mm (1.80-inch) hard drives and 45.72-mm (1.80-inch) solid-state drives
Customer-accessible
Serial ATA
HP 3D DriveGuard

Supports the following drives:

■ 250-GB, 5400-rpm hard drive

■ 160-GB, 5400-rpm hard drive

■ 120-GB, 5400-rpm hard drive

■ 80-GB, 5400-rpm hard drive

■ 128-GB solid-state drive

■ 80-GB solid-state drive

Optical drives Supports external optical drive only through docking station

Diskette drive Supports external USB diskette drive only
Supports boot from USB device

Microphone Integrated dual array microphone

Audio Analog Devices AD1984A high-definition audio
Single speaker

Webcam Optional 2.1-megapixel webcam with business card reader support
Business card slot

Modem 56K V.92 1.5-inch data/fax modem with digital line guard
Modem cable is included
Supports no-modem option

Ethernet Intel 10/100/1000 network interface card (NIC)
NIC power-down technology
Ethernet cable included
S4/S5 wake on LAN

Wireless Integrated WLAN options by way of wireless module:
2 wireless antennae built into display assembly
Supports no-WLAN option

Supports the following WLAN formats:

■ Broadcom 802.11a/b/g/n

■ Broadcom 802.11b/g

■ 802.11a/b/g/n Intel with iAMT support

■ 802.11a/b/g Intel with iAMT support

Integrated wireless wide area network (WWAN) options by way of wireless module:
HSPDA EV-DO WWAN module
2 WWAN antennae built into display assembly (worldwide 5-band)
Supports aftermarket WWAN option

Subscriber identify module (SIM) user-accessible behind primary battery

Integrated personal area network (PAN) options by way of Bluetooth® module:
Support for no-WPAN option
Broadcom Bluetooth

External media card One ExpressCard slot, supporting optional ExpressCard/54 cards
SD Card Reader supporting MultiMediaCard (MMC) and Secure Digital (SD) Memory Cards

(Continued)
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Product description
Docking HP 2700 Ultra-Slim Expansion Base support
Signals passed through docking connector:

■ External monitor

■ Headphone

■ Microphone

■ Optical drive support

■ Power

■ RJ-45

■ USB 2.0

Ports 1394a
Audio-in (mono microphone)
Audio-out (stereo headphone)
Multi-pin AC power
RJ-11 (modem)
RJ-45 (Ethernet, includes link and activity lights)
USB (2, one powered)
VGA (Dsub 15-pin) supporting 1600 × 1200 external resolution at 75 GHz (hot plug/unplug 
with auto-detect)

Keyboard/pointing device Spill-resistant 27.1-mm (10.7-inch) keyboard
Dual-point configuration (TouchPad with 2 TouchPad buttons and pointing stick with 2 
pointing stick buttons)
Durable key caps
Taps enabled as default

Power requirements 65-W HP Smart AC adapter with localized cable plug support (3-wire plug with ground pin, 
supports 3-pin DC connector)
6-cell, 2.25-Ah (44-Wh) Li-ion battery
Supports HP2700 Ultra-Slim Battery (travel battery)

Security Supports security cable slot
Optional integrated Active Smart card reader
Integrated trusted platform module (TPM) 1.2 chip (soldered to system board)
Integrated USB-based fingerprint reader

Operating system Preinstalled without Microsoft® Office:
Windows Vista® Business 32
Windows Vista Business 32 with Windows® XPTablet image
FreeDOS

Preinstalled with Microsoft Office:
Windows Vista Business 32 with Microsoft Office 2007 Ready
Windows Vista Business 32 with Windows XPTablet image and Microsoft Office 2007 Ready
Windows Vista Ultimate 32 with Microsoft Office 2007 Ready
Windows Vista Ultimate 32 with Windows XPTablet image and Microsoft Office 2007 Ready
Windows Vista Business 32 with Microsoft Office 2007 Personal
Windows Vista Business 32 with Windows XPTablet image and Microsoft Office 
2007 Personal
Windows Vista Business 32 with Microsoft Office 2007 Personal and PowerPoint
Windows Vista Business 32 with Windows XPTablet image, Microsoft Office 2007 Personal, 
and PowerPoint
Windows Vista Business 32 with Microsoft Office 2007 Pro
Windows Vista Business 32 with Windows XPTablet image and Microsoft Office 2007 Pro

(Continued)
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Product description
Operating system Restore media:
Windows Vista Business 32
Windows Vista Business 64
Windows Vista Ultimate 32
Windows Vista DRDVD
Windows XPTablet
Windows XPTablet DRDVD
Microsoft Office Ready restore DVD

Certified: Novell SuSE Linux

Web support:
Windows Vista Enterprise 32
Windows Vista Enterprise 64

Serviceability End-user replaceable parts:

■ AC adapter

■ Battery (system)

■ Hard drive

■ Memory module

■ Optical drive

■ WLAN module

■ WWAN module

Category Description
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External component identification

Top components

Wireless antenna locations

To see wireless regulatory notices, refer to the section of the Regulatory, Safety and Environmental Notices that 
applies to your country or region. These notices are located in Help and Support.

Item Component Description

1 WWAN antenna* Sends and receives wireless signals to communicate with wireless wide area 
networks (WWAN).

2 WLAN antennae (2)* Send and receive wireless signals to communicate with wireless local area 
networks (WLAN).

3 External WWAN antenna Sends and receives wireless signals to communicate with wireless wide area 
networks (WWAN).

*These antennae are not visible from the outside of the computer. For optimal transmission, keep the areas immediately 
around the antennae free from obstructions.
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External component identification
Display components

Item Component Description

1 Webcam light (select models only) On: The webcam is in use.

2 Webcam (select models only) Records audio and video and captures still photographs.

3 Keyboard light button Opens and turns on the keyboard light.

4 Keyboard light Illuminates the keyboard in low-light conditions when the keyboard light button 
is pressed.

5 HP Fingerprint Sensor 
(fingerprint reader)

Allows a fingerprint logon to Windows instead of a password logon.

6 Internal microphones (2) Record sound and transmit sound for video conferencing and Voice Over 
IP (VoIP).

7 Ambient light sensor Automatically adjusts the display brightness based on the lighting conditions 
in your environment.

8 Convertible hinge Swivels the display and converts the computer from traditional notebook 
mode into tablet mode or vice versa.
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External component identification
Buttons and switches

Item Component Description

1 Internal display switch Turns off the display if the display is closed while the power is on.

2 Presentation button Starts the presentation feature.

3 Volume mute button Mutes and restores speaker sound.

4 Volume scroll zone Adjusts speaker volume:

■ To decrease volume, slide your finger across the volume scroll zone from 
right to left. You can also press and hold the left end of the volume 
scroll zone.

■ To increase volume, slide your finger across the volume scroll zone from 
left to right. You can also press and hold the right end of the volume 
scroll zone.
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External component identification
Keys

Item Component Description

1 esc key Displays system information when pressed in combination with the fn key.

2 fn key Executes frequently used system functions when pressed in combination with 
a function key or the esc key.

3 Windows logo key Displays the Windows Start menu.

4 Windows applications key Displays a shortcut menu for items beneath the pointer.

5 Embedded numeric keypad keys Can be used like the keys on an external numeric keypad.

6 Function keys Execute frequently used system functions when pressed in combination with 
the fn key.
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External component identification
Lights

Item Component Description

1 Power light ■ On: The computer is on.

■ Blinking: The computer is in the Sleep state (Windows Vista) or Standby 
(Windows XP).

■ Off: The computer is off or in Hibernation.

2 Battery light ■ Amber: A battery is charging.

■ Turquoise: A battery is close to full charge capacity.

■ Blinking amber: A battery that is the only available power source has 
reached a low battery level. When the battery reaches a critical battery 
level, the battery light begins blinking rapidly.

■ Off: If the computer is plugged into an external power source, the light turns 
off when all batteries in the computer are fully charged. If the computer is 
not plugged into an external power source, the light stays off until the 
battery reaches a low battery level.

3 Drive light ■ Blinking turquoise: The hard drive is being accessed.

■ Amber: HP 3D DriveGuard has temporarily parked the internal hard drive.

4 Caps lock light On: Caps lock is on.

5 TouchPad light ■ Off: TouchPad is enabled.

■ Amber: TouchPad is disabled.

6 Volume mute light ■ Turquoise: Computer sound is on.

■ Amber: Computer sound is off.

7 Volume down light Blinking: The volume scroll zone is being used to decrease speaker volume.

8 Volume up light Blinking: The volume scroll zone is being used to increase speaker volume.

9 Num lock light On: Num lock is on or the embedded numeric keypad is enabled.
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External component identification
Pointing devices

Item Component Description

1 TouchPad light ■ Off: TouchPad is enabled.

■ Amber: TouchPad is disabled.

2 TouchPad on/off control Enables/disables the TouchPad when pressed in combination with the fn key.

3 Pointing stick* Moves the pointer and selects or activates items on the screen.

4 fn key Enables/disables the TouchPad when pressed in combination with the f5 key.

5 Left pointing stick button* Functions like the left button on an external mouse.

6 TouchPad* Moves the pointer and selects or activates items on the screen.

7 Left TouchPad button* Functions like the left button on an external mouse.

8 Right TouchPad button* Functions like the right button on an external mouse.

9 TouchPad scroll zone* Scrolls up or down.

- Right pointing stick button* Functions like the right button on an external mouse.

*This table describes factory settings. To view or change pointing device preferences, select Start > Control Panel > 
Hardware and Sound > Mouse.
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External component identification
Front components

Item Component Description

1 Power switch ■ When the computer is off, slide the switch to the right to turn on 
the computer.

■ When the computer is on, slide the switch to the right to shut down 
the computer.

■ When the computer is in the Sleep state (Windows Vista) or Standby 
(Windows XP), slide the switch to the right briefly to exit the Sleep state 
or Standby.

■ When the computer is in Hibernation, slide the switch to the right briefly to 
exit Hibernation.

If the computer has stopped responding and Windows shutdown procedures 
are ineffective, slide the switch to the right and hold for at least 5 seconds to 
turn off the computer.
To learn more about your power settings, select Start > Control Panel > 
System and Maintenance > Power Options.

2 Business card slot Holds a business card in position so that the webcam can capture an image.

3 Display release latch Opens the computer.

4 Keyboard light button Opens and turns on the keyboard light.

5 External WWAN antenna button Opens the external WWAN antenna.

6 Bluetooth compartment Contains an optional Bluetooth device.
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External component identification
Right-side components

Item Component Description

1 HP Fingerprint Sensor 
(fingerprint reader)

Allows a fingerprint logon to Windows instead of a password logon.

2 1394 port Connects an optional IEEE 1394 or 1394a device, such as a camcorder.

3 Audio-out (headphone) jack Produces sound when connected to optional powered stereo speakers, 
headphones, ear buds, a headset, or television audio.

4 Audio-in (microphone) jack Connects an optional computer headset microphone, stereo array 
microphone, or monaural microphone.

5 SD Card Reader Supports the following optional digital card formats:

■ Secure Digital (SD) Memory Card

■ MultiMediaCard (MMC)

6 USB port Connects an optional USB device.

7 Security cable slot Attaches an optional security cable to the computer.

✎ The security cable is designed to act as a deterrent, but it may not 
prevent the computer from being mishandled or stolen.
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External component identification
Left-side components

✎ Refer to the illustration that most closely matches your computer.

Item Component Description

1 Pen holder Stores the pen.

2 Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

3 ExpressCard slot (select models only) Supports optional ExpressCards.

4 Wireless switch Turns the wireless feature on or off, but does not create a wireless connection.

✎ A wireless network must be set up in order to establish a 
wireless connection.

5 Wireless light ■ Blue: An integrated wireless device, such as a wireless local area network 
(WLAN) device, the HP Mobile Broadband Module, and/or a Bluetooth 
device, is on.

■ Amber: All wireless devices are off.

6 Info button Launches Info Center, which enables you to open various software solutions.

7 Powered USB port Provides power to a USB device, such as an optional external MultiBay, if 
used with a powered USB cable.
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External component identification
Item Component Description

1 Pen holder Stores the pen.

2 Vent Enables airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

3 Smart card reader (select 
models only)

Supports optional smart cards and Java™ Cards.

4 Wireless switch Turns the wireless feature on or off, but does not create a wireless connection.

✎ A wireless network must be set up in order to establish a wireless 
connection.

5 Wireless light ■ Blue: An integrated wireless device, such as a wireless local area network 
WLAN device, the HP Mobile Broadband Module, and/or a Bluetooth 
device, is on.

■ Amber: All wireless devices are off.

6 Info button Launches Info Center, which enables you to open various software solutions.

7 Powered USB port Provides power to a USB device, such as an optional external MultiBay, if 
used with a powered USB cable.
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External component identification
Rear components

Item Component Description

1 Jog dial In tablet mode, functions like the enter key and the up and down arrows on a 
standard keyboard.

■ Press inward to enter a command.

■ Rotate up to scroll up.

■ Rotate down to scroll down.

2 Esc button In tablet mode, allows you to exit or escape out of an application.

3 Rotate button In tablet mode, switches the image between landscape and portrait 
orientation.

4 Ctrl+alt+del button In tablet mode:

■ While Windows is running, press the button with the pen to enter the 
ctrl+alt+del command.*

■ While the Computer Setup utility is running, press the button with the pen 
to enter the reset command. The computer resets and all unsaved 
information is lost. The reset function can be used to restore functionality 
when the system has become unresponsive.

5 RJ-11 (modem) jack Connects a modem cable.

6 RJ-45 (network) jack Connects a network cable.

7 External monitor port Connects an external VGA monitor or projector.

8 Power connector Connects an AC adapter.

*To protect your work and the system, the ctrl+alt+delete command cannot be entered using the ctrl, alt, and del keys on the 
on-screen keyboard.
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External component identification
Bottom components

Item Component Description

1 Hard drive bay Holds the hard drive, memory module slots, WLAN module (select models 
only), and WWAN module (select models only).

2 Vents (4) Enable airflow to cool internal components.

✎ The computer fan starts up automatically to cool internal components 
and prevent overheating. It is normal for the internal fan to cycle on and 
off during routine operation.

3 Speaker Produces sound.

4 Battery bay Holds the battery and subscriber identity module (SIM).

5 Charge level indicator Displays the approximate remaining battery charge.

6 Accessory battery connector door Slides open to expose the accessory battery connector.

7 Accessory battery connector Connects an optional accessory battery.

8 Battery release latch Releases the battery from the battery bay.

9 Docking connector Connects an optional docking device.
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Illustrated parts catalog

Serial number location

The service tag, affixed to the bottom of the computer, provides information that may be needed when 
troubleshooting system problems. The service tag provides the following information:

1 Product name: This is the product name affixed to the front of the computer.

2 Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

3 Part number/Product number (p/n): This number provides specific information about the product's hardware 
components. The part number helps a service technician to determine what components and parts are needed.

4 Model description: This is the number used to locate documents, drivers, and support for the computer.

5 Warranty period: This number describes the duration of the warranty period for the computer.

When ordering parts or requesting information, provide the computer serial number and model description 
provided on the service tag.
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Illustrated parts catalog
Computer major components
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Illustrated parts catalog
Item Description Spare Part Number

(1) Display assembly (includes ambient light sensor, fingerprint reader, logo, 2 microphones, 
nameplate, 2 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers 
and cables)

12.1-inch, WXGA LED display assembly with webcam and outdoor light 504172-001

12.1-inch, WXGA LED display assembly with webcam 504170-001

12.1-inch, WXGA LED display assembly with outdoor light 504171-001

12.1-inch, WXGA LED display assembly 504169-001

(2) Keyboard (includes keyboard cable)

For use in Belgium 501493-A41

For use in Brazil 501493-201

For use the Czech Republic 501493-211

For use in Denmark 501493-081

For use in Finland and Sweden 501493-B71

For use in France 501493-051

For use in French Canada 501493-121

For use in Germany 501493-041

For use in Greece 501493-DJ1

For use in Hungary 501493-221

For use in Iceland 501493-DD1

For use in Israel 501493-BB1

For use in Italy 501493-061

For use in Japan 501493-291

For use in Latin America 501493-161

For use in the Netherlands 501493-B31

For use in Norway 501493-091

For use in Portugal 501493-131

For use in Russia 501493-251

For use in Saudi Arabia 501493-171

For use in Slovakia 501493-231

For use in Slovenia 501493-BA1

For use in South Korea 501493-AD1

For use in Spain 501493-071

For use in Switzerland 501493-BG1

For use in Taiwan 501493-AB1

For use in Thailand 501493-281

For use in Turkey 501493-141

For use in the United Kingdom 501493-031

For use in the United States 501493-001

(Continued)
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Illustrated parts catalog
Plastics Kit, includes: 501499-001

(3a) Hinge cover

(3b) ExpressCard slot bezel

(3c) Hard drive cover (includes 6 captive screws, secured by C-clips)

✎ See “Plastics Kit” on page 3-9 for more Plastics Kit spare part information.

(4) Top cover (includes LED board and cable and display alignment guides) 501502-001

(5) RTC battery (includes double-sided tape) 482963-001

(6) Audio connector board (includes cable) 507056-001

(7) Bluetooth module

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The 
Bluetooth module cable is included in the Cables Kit, spare part number 501500-001.

483113-001

(8) Speaker 507057-001

(9) Modem module (includes module cable):

For use only in Australia and New Zealand 461750-011

For use in all countries and regions except Australia and New Zealand 461750-001

(10) System board (includes replacement thermal material)

For use in all countries and regions except for Russia and the People’s Republic of China

■ Equipped with Intel Core2 Duo SL9600 2.13-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache

530589-001

■ Equipped with Intel Core2 Duo SL9400 1.86-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache

501483-001

■ Equipped with Intel Core2 Duo SL9300 1.60-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache

501482-001

■ Equipped with Intel Core2 Duo SU9400 1.40-GHz processor, 800-MHz FSB, and 
3-MB L2 cache

530590-001

■ Equipped with Intel Core2 Duo SU9300 1.20-GHz processor, 800-MHz FSB, and 
3-MB L2 cache

501481-001

For use in Russia and the People’s Republic of China

■ Equipped with Intel Core2 Duo SL9600 2.13-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache

598660-001

■ Equipped with Intel Core2 Duo SL9400 1.86-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache

510371-001

■ Equipped with Intel Core2 Duo SL9300 1.60-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache

510370-001

■ Equipped with Intel Core2 Duo SU9400 1.40-GHz processor, 800-MHz FSB, and 
3-MB L2 cache

598661-001

■ Equipped with Intel Core2 Duo SU9300 1.20-GHz processor, 800-MHz FSB, and 
3-MB L2 cache

510369-001

(11) Fan/heat sink assembly (includes replacement thermal material) 501495-001

(12) Base enclosure (includes display release latch and rubber feet) 501501-001

Rubber Kit (not illustrated; includes 4 rubber feet, 5 Mylar screw covers, and 2 display 
alignment guides)

501496-001

(13) 6-cell, 4.4-Wh battery 534060-291

(14) Shield Kit, includes system board shield (not illustrated) and wireless compartment shield 501503-001

(Continued)

Item Description Spare Part Number
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Illustrated parts catalog
(15) WLAN module:

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions 482957-001

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in Russia, Ukraine, and Pakistan 506678-001

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions 480985-001 

Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, 
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, 
the U.S. Virgin Islands, and the United States

487330-001 

Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, 
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, 
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, 
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, 
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, 
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, 
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, 
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, 
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, 
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, 
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, 
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, 
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, 
Belize, Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, 
the U.S. Virgin Islands, and the United States

459263-001

(Continued)

Item Description Spare Part Number
Maintenance and Service Guide 3–5



Illustrated parts catalog
Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, 
Andorra, Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, 
Azerbaijan, the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, 
Bermuda, Bhutan, Bolivia, Bosnia and Herzegovina, Botswana, Brazil, 
the British Virgin Islands, Brunei, Bulgaria, Burkina Faso, Burundi, Cameroon, Cape Verde, 
the Central African Republic, Chad, Chile, the People's Republic of China, Colombia, 
Comoros, the Congo, Costa Rica, Croatia, Cyprus, the Czech Republic, Denmark, Djibouti, 
Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, El Salvador, 
Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, Gabon, 
Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, 
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, 
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, 
Kyrgyzstan, Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, 
Macedonia, Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, 
Martinique, Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, 
Morocco, Mozambique, Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, 
New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, Palau, Panama, 
Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, 
Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, 
Spain, Sri Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, 
Swaziland, Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, 
Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, 
the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, Venezuela, 
Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

(16) HSPDA EV-DO WWAN module 483377-002

(17) Hard drive (includes bracket, isolator and connector cable)

250-GB, 5400-rpm 577990-001

160-GB, 5400-rpm 509435-001

120-GB, 5400-rpm 501491-001

80-GB, 5400-rpm 501490-001

128-GB solid-state drive (includes bracket, isolator and connector cable) 574995-001

80-GB solid-state drive (includes bracket, isolator and connector cable) 501492-001

Hard drive connector cable (not illustrated) 504519-001

(18) Memory module (PC2-6400, 800-MHz, DDR2)

4096-MB 598855-001

2048-MB 598858-001

1024-MB 598861-001

Cable Kit (not illustrated, includes audio connector board cable, see “Cable Kit” on page 3-7 
for more Cable Kit information)

501500-001

Smart card reader (not illustrated) 501497-001

Item Description Spare Part Number
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Illustrated parts catalog
Cable Kit

Item Description Spare part number

Cable Kit: 501500-001

(1) Audio connector board cable

(2) Bluetooth module cable
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Illustrated parts catalog
Mass storage devices

Item Description Spare part number

(1) Hard drive (includes bracket, isolator and connector cable)

250-GB, 5400-rpm 577990-001

160-GB, 5400-rpm 509435-001

120-GB, 5400-rpm 501491-001

80-GB, 5400-rpm 501490-001

(2) Solid-state drive (includes bracket, isolator and connector cable)

128-GB 574995-001

80-GB 501492-001

Hard drive connector cable (not illustrated) 504519-001
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Illustrated parts catalog
Plastics Kit

Item Description Spare part number 

Plastics Kit: 501499-001 

(1) Hinge cover

(2) ExpressCard slot bezel

(3) Hard drive cover (includes one captive screw, secured by a C-clip)
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Miscellaneous parts

Description Spare part number 

AC adapters

65-W 463958-001

65-W for use in India 577170-001

65-W (3-wire power cord) 609939-001

65-W for use in India (3-wire power cord) 609948-001

Power cords: 

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-201

For use in the People’s Republic of China 490371-AA1

For use in Europe, the Middle East, and Africa 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Italy 490371-061

For use in Japan 490371-291

For use in North America 490371-001 

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1

For use in the United Kingdom 490371-031

Screw Kit 

■ Phillips PM2.5×7.0 captive screw

■ Phillips PM2.5×4.0 screw

■ Phillips PM2.0×5.0 captive screw

■ Phillips PM2.0×5.0 screw

■ Phillips PM2.0×4.0 screw

■ Phillips PM2.0×3.0 screw

■ Torx T8M2.5×6.0 screw

■ Torx T8M2.0×8.0 screw

■ Torx T8M2.0×5.0 screw

501498-001

Antenna, external 592489-001

Pointing stick rubber cap 486565-001

HP Docking Station 455953-001

Pen with tether 501494-001
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Sequential part number listing

Spare part number Description

455953-001 HP Docking Station

459263-001 Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, 
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, 
and the United States

459263-002 Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, 
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, 
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, 
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French 
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, 
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, 
Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, 
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, 
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, 
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the 
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San 
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri 
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, 
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, 
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, 
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

461750-001 Modem module for use in all countries and regions except Australia and New Zealand (includes 
module cable)

461750-011 Modem module for use only in Australia and New Zealand (includes module cable)

463958-001 65-W AC adapter

480985-001 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions

482957-001 Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions

482963-001 RTC battery (includes double-sided tape)

483113-001 Bluetooth module

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The 
Bluetooth module cable is included in the Cables Kit, spare part number 501500-001.

483377-002 HSPDA EV-DO WWAN module

486565-001 Pointing stick rubber cap

487330-001 Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, 
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, 
and the United States

(Continued)
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487330-002 Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, 
the Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, 
the People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, 
the Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, 
Egypt, El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French 
Guiana, Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, 
Guatemala, Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, 
Ireland, Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, 
Laos, Latvia, Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, 
Madagascar, Malawi, Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, 
Mauritania, Mauritius, Mexico, Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, 
Namibia, Nauru, Nepal, the Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, 
Nigeria, Norway, Oman, Pakistan, Palau, Panama, Papua New Guinea, Paraguay, Peru, the 
Philippines, Poland, Portugal, the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San 
Marino, Sao Tome and Principe, Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, 
Singapore, Slovakia, Slovenia, the Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri 
Lanka, St. Kitts and Nevis, St. Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, 
Sweden, Switzerland, Taiwan, Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, 
Turkey, Turkmenistan, Tuvalu, Uganda, Ukraine, the United Arab Emirates, the United Kingdom, 
Uruguay, Uzbekistan, Vanuatu, Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

490371-001 Power cord for use in North America

490371-011 Power cord for use in Australia

490371-021 Power cord for use in Europe, the Middle East, and Africa

490371-031 Power cord for use in the United Kingdom

490371-061 Power cord for use in Italy

490371-011 Power cord for use in Switzerland

490371-201 Power cord for use in Brazil

490371-291 Power cord for use in Japan

490371-AA1 Power cord for use in the People’s Republic of China

490371-AB1 Power cord for use in Taiwan

490371-AD1 Power cord for use in South Korea

490371-AR1 Power cord for use in South Africa

490371-BB1 Power cord for use in Israel

490371-D01 Power cord for use in Argentina

490371-D61 Power cord for use in India

501481-001 System board equipped with Intel Core2 Duo SU9300 1.20-GHz processor, 800-MHz FSB, and 
3-MB L2 cache (includes thermal replacement material) for use in all countries and regions except 
for Russia and the People’s Republic of China

501482-001 System board equipped with Intel Core2 Duo SL9300 1.60-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache (includes thermal replacement material) for use in all countries and regions except 
for Russia and the People’s Republic of China

501483-001 System board equipped with Intel Core2 Duo SL9400 1.86-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache (includes thermal replacement material) for use in all countries and regions except 
for Russia and the People’s Republic of China

501490-001 80-GB, 5400-rpm, 1.8-inch hard drive (include bracket, isolator and connector cable)

(Continued)
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501491-001 120-GB, 5400-rpm, 1.8-inch hard drive (include bracket, isolator and connector cable)

501492-001 1.8-inch, 80-GB solid-state drive (include bracket, isolator and connector cable)

501494-001 Pen with tether

501497-001 Smart card reader

501493-001 Keyboard for use in the United States

501493-031 Keyboard for use in the United Kingdom

501493-041 Keyboard for use in Germany

501493-051 Keyboard for use in France

501493-061 Keyboard for use in Italy

501493-071 Keyboard for use in Spain

501493-081 Keyboard for use in Denmark

501493-091 Keyboard for use in Norway

501493-121 Keyboard for use in French Canada

501493-131 Keyboard for use in Portugal

501493-141 Keyboard for use in Turkey

501493-161 Keyboard for use in Latin America

501493-171 Keyboard for use in Saudi Arabia

501493-201 Keyboard for use in Brazil

501493-211 Keyboard for use in the Czech Republic

501493-221 Keyboard for use in Hungary

501493-231 Keyboard for use in Slovakia

501493-251 Keyboard for use in Russia

501493-281 Keyboard for use in Thailand

501493-291 Keyboard for use in Japan

501493-A41 Keyboard for use in Belgium

501493-AB1 Keyboard for use in Taiwan

501493-AD1 Keyboard for use in South Korea

501493-B31 Keyboard for use in the Netherlands

501493-B71 Keyboard for use in Finland and Sweden

501493-BB1 Keyboard for use in Israel

501493-BG1 Keyboard for use in Switzerland

501493-DD1 Keyboard for use in Iceland

501493-DJ1 Keyboard for use in Greece

501495-001 Fan/heat sink assembly (includes replacement thermal material)

501496-001 Rubber Kit (includes 4 rubber feet, 5 Mylar screw covers, and 2 display alignment guides)

501498-001 Screw Kit

(Continued)
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501499-001 Plastics Kit

✎ See “Plastics Kit” on page 3-9 for more Plastics Kit spare part information.

501500-001 Cable Kit

✎ See “Cable Kit” on page 3-7 for more Cable Kit information.

501501-001 Base enclosure (includes display release latch and rubber feet)

501502-001 Top cover (includes LED board and cable and display alignment guides)

501503-001 Shield Kit

504169-001 12.1-inch, WXGA LED display assembly (includes ambient light sensor, fingerprint reader, logo, 2 
microphones, nameplate, 2 WLAN antenna transceivers and cables, and 2 WWAN antenna 
transceivers and cables)

504170-001 12.1-inch, WXGA LED display assembly with webcam (includes ambient light sensor, fingerprint 
reader, logo, 2 microphones, nameplate, 2 WLAN antenna transceivers and cables, and 2 WWAN 
antenna transceivers and cables)

504171-001 12.1-inch, WXGA LED display assembly with outdoor light (includes ambient light sensor, fingerprint 
reader, logo, 2 microphones, nameplate, 2 WLAN antenna transceivers and cables, and 2 WWAN 
antenna transceivers and cables)

504172-001 12.1-inch, WXGA LED display assembly with webcam and outdoor light (includes ambient light 
sensor, fingerprint reader, logo, 2 microphones, nameplate, 2 WLAN antenna transceivers and 
cables, and 2 WWAN antenna transceivers and cables)

504519-001 Hard drive connector cable

506678-001 Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in Russia, Ukraine, and Pakistan

507056-001 Audio connector board (includes cable)

507057-001 Speaker

509435-001 160-GB, 5400-rpm (include bracket, isolator and connector cable)

510369-001 System board equipped with Intel Core2 Duo SU9300 1.20-GHz processor, 800-MHz FSB, and 
3-MB L2 cache (includes thermal replacement material) for use in Russia and the People’s Republic 
of China

510370-001 System board equipped with Intel Core2 Duo SL9300 1.60-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache (includes thermal replacement material) for use in Russia and the People’s Republic 
of China

510371-001 System board equipped with Intel Core2 Duo SL9400 1.86-GHz processor, 1066-MHz FSB, and 
6-MB L2 cache (includes thermal replacement material) for use in Russia and the People’s Republic 
of China

530589-001 System board equipped with Intel Core2 Duo SL9600 2.13-GHz processor, 800-MHz FSB, and 
3-MB L2 cache (includes thermal replacement material) for use in all countries and regions except 
for Russia and the People’s Republic of China

530590-001 System board equipped with Intel Core2 Duo SU9400 1.40-GHz processor, 800-MHz FSB, and 
3-MB L2 cache (includes thermal replacement material) for use in all countries and regions except 
for Russia and the People’s Republic of China

534060-291 6-cell, 4.4-Wh battery

574995-001 1.8-inch, 128-GB solid-state drive (include bracket, isolator and connector cable)

577170-001 65-W AC adapter for use in India

577990-001 250-GB, 5400-rpm (include bracket, isolator and connector cable)

592489-001 Antenna, external

(Continued)
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598660-001 System board equipped with Intel Core2 Duo SL9600 2.13-GHz processor, 800-MHz FSB, and 
3-MB L2 cache (includes thermal replacement material) for use in Russia and the People’s Republic 
of China

598661-001 System board equipped with Intel Core2 Duo SU9400 1.40-GHz processor, 800-MHz FSB, and 
3-MB L2 cache (includes thermal replacement material) for use in for Russia and the People’s 
Republic of China

598855-001 4096-MB memory module (PC2-6400, 800-MHz, DDR2)

598858-001 2048-MB memory module (PC2-6400, 800-MHz, DDR2)

598861-001 1024-MB memory module (PC2-6400, 800-MHz, DDR2)

609939-001 65-W AC adapter (requires 3-wire power cord)

609948-001 65-W AC adapter for use in India (requires 3-wire power cord)

Spare part number Description
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Removal and replacement procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures: 

■ Flat-bladed screwdriver 

■ Magnetic screwdriver 

■ Phillips P0 and P1 screwdrivers 

■ Torx T8 screwdriver 

Service considerations

The following sections include some of the considerations that you must keep in mind during disassembly and 
assembly procedures. 

✎ As you remove each subassembly from the computer, place the subassembly (and all accompanying screws) 
away from the work area to prevent damage. 

Plastic parts

Ä
CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use care when handling the 
plastic parts. Apply pressure only at the points designated in the maintenance instructions.

Cables and connectors

Ä
CAUTION: When servicing the computer, be sure that cables are placed in their proper locations during the reassembly 
process. Improper cable placement can damage the computer. 

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat or seat the 
cables during removal and insertion. Handle cables by the connector whenever possible. In all cases, avoid 
bending, twisting, or tearing cables. Be sure that cables are routed in such a way that they cannot be caught or 
snagged by parts being removed or replaced. Handle flex cables with extreme care; these cables tear easily. 
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Drive handling

Ä
CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the computer, damage to a 
drive, or loss of information, observe these precautions:
■ Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the computer is off or in 

Hibernation, turn the computer on, and then shut it down through the operating system. 
■ Before handling a drive, be sure that you are discharged of static electricity. While handling a drive, avoid touching the 

connector.
■ Handle drives on surfaces covered with at least one inch of shock-proof foam. 
■ Avoid dropping drives from any height onto any surface.
■ After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.
■ Avoid exposing a hard drive to products that have magnetic fields, such as monitors or speakers. 
■ Avoid exposing a drive to temperature extremes or liquids. 
■ If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective packaging and label 

the package "FRAGILE."

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure determine the 
degree of sensitivity. Networks built into many integrated circuits provide some protection, but in many cases, ESD 
contains enough power to alter device parameters or melt silicon junctions. 

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or 
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred. 

An electronic device exposed to ESD may not be affected at all and may work perfectly throughout a normal cycle. 
Or the device may function normally for a while, and then degrade in the internal layers, reducing its 
life expectancy. 

Ä
CAUTION: To prevent damage to the computer when you are removing or installing internal components, observe these 
precautions:
■ Keep components in their electrostatic-safe containers until you are ready to install them.
■ Use nonmagnetic tools. 
■ Before touching an electronic component, discharge static electricity by using the guidelines described in this section.
■ Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.
■ If you remove a component, place it in an electrostatic-safe container.
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The following table shows how humidity affects the electrostatic voltage levels generated by different activities.

Ä
CAUTION: A product can be degraded by as little as 700 V. 

Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment: 

■ To avoid hand contact, transport products in static-safe tubes, bags, or boxes. 

■ Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging. 

■ Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations. 

■ Place items on a grounded surface before removing items from their containers. 

■ Always be properly grounded when touching a component or assembly. 

■ Store reusable ESD-sensitive parts from assemblies in protective packaging or nonconductive foam. 

■ Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that mechanized equipment 
used for moving materials is wired to ground and that proper materials are selected to avoid static charging. 
When grounding is not possible, use an ionizer to dissipate electric charges. 

Typical electrostatic voltage levels 

Relative humidity 

Event 10% 40% 55% 

Walking across carpet 35,000 V 15,000 V 7,500 V 

Walking across vinyl floor 12,000 V 5,000 V 3,000 V 

Motions of bench worker 6,000 V 800 V 400 V 

Removing DIPS from plastic tube 2,000 V 700 V 400 V 

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V 

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V 

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V 

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V 
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Workstation guidelines

Follow these grounding workstation guidelines: 

■ Cover the workstation with approved static-shielding material. 

■ Use a wrist strap connected to a properly grounded work surface and use properly grounded tools 
and equipment. 

■ Use conductive field service tools, such as cutters, screwdrivers, and vacuums. 

■ When fixtures must directly contact dissipative surfaces, use fixtures made only of static-safe materials. 

■ Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids and Styrofoam. 

■ Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle these items 
only at static-free workstations. 

■ Avoid contact with pins, leads, or circuitry. 

■ Turn off power and input signals before inserting or removing connectors or test equipment. 

Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation. 

■ When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps with a 
minimum of one megohm ±10% resistance in the ground cords. To provide proper ground, wear a strap snugly 
against the skin at all times. On grounded mats with banana-plug connectors, use alligator clips to connect a 
wrist strap. 

■ When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps) can be used at 
standing workstations and are compatible with most types of shoes or boots. On conductive floors or 
dissipative floor mats, use foot straps on both feet with a minimum of one megohm resistance between the 
operator and ground. To be effective, the conductive strips must be worn in contact with the skin. 

The following grounding equipment is recommended to prevent electrostatic damage: 

■ Antistatic tape 

■ Antistatic smocks, aprons, and sleeve protectors 

■ Conductive bins and other assembly or soldering aids 

■ Nonconductive foam 

■ Conductive tabletop workstations with ground cords of one megohm resistance 

■ Static-dissipative tables or floor mats with hard ties to the ground 

■ Field Service Kits 
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■ Static awareness labels 

■ Material-handling packages 

■ Nonconductive plastic bags, tubes, or boxes 

■ Metal tote boxes 

■ Electrostatic voltage levels and protective materials 

The following table lists the shielding protection provided by antistatic bags and floor mats. 

Unknown user password

If the computer you are servicing has an unknown user password, follow these steps to clear the password: 

✎ These steps also clear CMOS. 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the real-time clock (RTC) battery (see “RTC battery” on page 4-23). 

6. Wait approximately 5 minutes. 

7. Replace the RTC battery and reassemble the computer. 

8. Connect AC power to the computer. Do not reinsert any batteries at this time. 

9. Turn on the computer. 

All passwords and all CMOS settings have been cleared.

Material Use Voltage protection level 

Antistatic plastic Bags 1,500 V 

Carbon-loaded plastic Floor mats 7,500 V 

Metallized laminate Floor mats 5,000 V 
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Component replacement procedures

This chapter provides removal and replacement procedures. 

There are as many as 49 screws, in 9 different sizes, that must be removed, replaced, or loosened when servicing 
the computer. Make special note of each screw size and location during removal and replacement. 

Serial number location

The service tag, affixed to the bottom of the computer, provides information that may be needed when 
troubleshooting system problems. The service tag provides the following information:

1 Product name: This is the product name affixed to the front of the computer.

2 Serial number (s/n): This is an alphanumeric identifier that is unique to each product.

3 Part number/Product number (p/n): This number provides specific information about the product's hardware 
components. The part number helps a service technician to determine what components and parts are needed.

4 Model description: This is the number used to locate documents, drivers, and support for the computer.

5 Warranty period: This number describes the duration of the warranty period for the computer.

When ordering parts or requesting information, provide the computer serial number and model description 
provided on the service tag.
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Computer feet

The computer feet are adhesive-backed rubber pads. The feet are included in the Rubber Kit, spare part number 
501496-001. There are four rubber feet that attach to the base enclosure in the locations illustrated below.
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Battery

Before disassembling the computer, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

Remove the battery: 

1. Turn the computer upside down on a flat surface, with the battery bay toward you. 

2. Slide the battery release latch 1 to release the battery.

3. Pivot the rear edge of the battery 2 upward and remove it 3 from the computer.

To insert the battery, insert the front edge of the battery into the battery bay and pivot the rear edge of the battery 
downward until it is seated. The battery release latch automatically locks the battery into place.

Description Spare part number 

6-cell, 4.4-Wh battery 534060-291
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SIM

✎ This section applies only to computer models with WWAN capability.

✎ If there is a SIM inserted in the SIM slot, it must be removed before disassembling the computer. Be sure that the 
SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8).

Remove the SIM:

1. Press in on the SIM 1. (The module is partially ejected from the SIM slot.)

2. Remove the SIM 2 from the SIM slot.

Reverse this procedure to install the SIM.
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Hard drive

✎ The hard drive spare part kit includes a hard drive bracket, hard drive isolator, and hard drive connector cable.

Before removing the hard drive, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the SIM (see “SIM” on page 4-9). 

Remove the hard drive:

1. Loosen the six Phillips PM2.0×5.0 captive screws 1 that secure the hard drive cover to the computer. 

2. Lift the rear edge of the hard drive cover 2 until it rests at an angle, and then remove the hard drive cover. 
The hard drive cover is included in the Plastics Kit, spare part number 501499-001.

Description Spare part number

250-GB, 5400-rpm, 1.8-inch hard drive 577990-001

160-GB, 5400-rpm, 1.8-inch hard drive 509435-001

120-GB, 5400-rpm, 1.8-inch hard drive 501490-001

80-GB, 5400-rpm, 1.8-inch hard drive 501491-001

128-GB solid-state drive 574995-001

80-GB solid-state drive 501492-001

Hard drive connector cable 504519-001
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3. Remove the two Phillips PM2.0×3.0 screws 1 that secure the hard drive bracket to the computer.

4. Remove the hard drive bracket 2.

5. Disconnect the hard drive connector cable 1 from the system board.

6. Release the hard drive 2 by sliding it to the right, and then lifting the rear edge 3 until the hard drive rests at 
an angle.

7. Lift the hard drive 4 straight up to remove it from the hard drive compartment.

Reverse this procedure to reassemble and install the hard drive. 
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WLAN module

Ä
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Description Spare part number

Intel Wi-Fi Link 5100 802.11a/b/g WLAN module for use in all countries and regions 482957-001

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in all countries and regions 480985-001

Intel Wi-Fi Link 5100 802.11a/b/g/n WLAN module for use in Russia, Ukraine, and Pakistan 506678-001

Broadcom 4322 802.11a/b/g/n WLAN module for use in Antigua and Barbuda, Barbados, Belize, 
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and 
the United States

487330-001

Broadcom 4322 802.11a/b/g/n WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the 
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the 
People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the 
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, 
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, 
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, 
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, 
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the 
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, 
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, 
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the 
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. 
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, 
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, 
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

487330-002

Broadcom BCM4312 802.11b/g WLAN module for use in Antigua and Barbuda, Barbados, Belize, 
Canada, the Cayman Islands, Guam, Puerto Rico, Trinidad and Tobago, the U.S. Virgin Islands, and 
the United States

459263-001

(Continued)
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Removal and replacement procedures
Before removing the WLAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the SIM (see “SIM” on page 4-9). 

6. Remove the hard drive cover (see “Hard drive” on page 4-10).

Broadcom BCM4312 802.11b/g WLAN module for use in Afghanistan, Albania, Algeria, Andorra, 
Angola, Antigua and Barbuda, Argentina, Armenia, Aruba, Australia, Austria, Azerbaijan, the 
Bahamas, Bahrain, Bangladesh, Barbados, Belarus, Belgium, Belize, Benin, Bermuda, Bhutan, 
Bolivia, Bosnia and Herzegovina, Botswana, Brazil, the British Virgin Islands, Brunei, Bulgaria, 
Burkina Faso, Burundi, Cameroon, Cape Verde, the Central African Republic, Chad, Chile, the 
People's Republic of China, Colombia, Comoros, the Congo, Costa Rica, Croatia, Cyprus, the 
Czech Republic, Denmark, Djibouti, Dominica, the Dominican Republic, East Timor, Ecuador, Egypt, 
El Salvador, Equitorial Guinea, Eritrea, Estonia, Ethiopia, Fiji, Finland, France, French Guiana, 
Gabon, Gambia, Georgia, Germany, Ghana, Gibraltar, Greece, Grenada, Guadeloupe, Guatemala, 
Guinea, Guinea-Bissau, Guyana, Haiti, Honduras, Hong Kong, Hungary, Iceland, India, Ireland, 
Israel, Italy, the Ivory Coast, Jamaica, Jordan, Kazakhstan, Kenya, Kiribati, Kyrgyzstan, Laos, Latvia, 
Lebanon, Lesotho, Liberia, Liechtenstein, Lithuania, Luxembourg, Macedonia, Madagascar, Malawi, 
Malaysia, the Maldives, Mali, Malta, the Marshall Islands, Martinique, Mauritania, Mauritius, Mexico, 
Micronesia, Monaco, Mongolia, Montenegro, Morocco, Mozambique, Namibia, Nauru, Nepal, the 
Nether Antilles, the Netherlands, New Zealand, Nicaragua, Niger, Nigeria, Norway, Oman, Pakistan, 
Palau, Panama, Papua New Guinea, Paraguay, Peru, the Philippines, Poland, Portugal, 
the Republic of Moldova, Romania, Russia, Rwanda, Samoa, San Marino, Sao Tome and Principe, 
Saudi Arabia, Senegal, Serbia, the Seychelles, Sierra Leone, Singapore, Slovakia, Slovenia, the 
Solomon Islands, Somalia, South Africa, South Korea, Spain, Sri Lanka, St. Kitts and Nevis, St. 
Lucia, St. Vincent and the Grenadines, Suriname, Swaziland, Sweden, Switzerland, Taiwan, 
Tajikistan, Tanzania, Togo, Tonga, Trinidad and Tobago, Tunisia, Turkey, Turkmenistan, Tuvalu, 
Uganda, Ukraine, the United Arab Emirates, the United Kingdom, Uruguay, Uzbekistan, Vanuatu, 
Venezuela, Vietnam, Yemen, Zaire, Zambia, and Zimbabwe

459263-002

Description Spare part number
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Removal and replacement procedures
Remove the WLAN module: 

1. Disconnect the WLAN antenna cables 1 from the terminals on the WLAN module. 

✎The black WLAN antenna cable is connected to the WLAN module “Main” terminal. The white WLAN antenna 
cable is connected to the WLAN module “Aux” terminal. 

2. Remove the two Phillips PM2.5×4.0 screws 2 that secure the WLAN module to the computer. (The edge of the 
module opposite the slot rises away from the computer.) 

3. Remove the WLAN module 3 by pulling the module away from the slot at an angle. 

✎WLAN modules are designed with a notch 4 to prevent incorrect insertion into the WLAN module slot.

Reverse this procedure to install the WLAN module. 
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Removal and replacement procedures
WWAN module

Ä
CAUTION: The WLAN module and the WWAN module are not interchangeable.

Before removing the WWAN module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the SIM (see “SIM” on page 4-9). 

6. Remove the hard drive cover (see “Hard drive” on page 4-10).

Remove the WWAN module: 

1. Disconnect the WWAN antenna cables 1 from the terminals on the WWAN module. 

✎The red WWAN antenna cable is connected to the WWAN module “Main” terminal. The blue WWAN antenna 
cable is connected to the WWAN module “Aux” terminal. 

2. Remove the two Phillips PM2.5×4.0 screws 2 that secure the WWAN module to the computer. (The edge of 
the module opposite the slot rises away from the computer.) 

3. Remove the WWAN module 3 by pulling the module away from the slot at an angle. 

✎WWAN modules are designed with a notch 4 to prevent incorrect insertion into the WWAN module slot.

Reverse this procedure to install the WWAN module. 

Description Spare part number 

HSPDA EV-DO WWAN module 483377-002
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Removal and replacement procedures
Memory module

Before removing the memory module, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the SIM (see “SIM” on page 4-9). 

6. Remove the hard drive cover (see “Hard drive” on page 4-10).

Remove the memory module:

✎ The top memory module slot is for extension memory and the bottom slot is for primary memory.

1. Spread the retaining tabs 1 on each side of the memory module to release the memory module. (The edge of 
the module opposite the slot rises away from the computer.) 

2. Remove the memory module 2 by pulling the module away from the slot at an angle. 

✎Memory modules are designed with a notch 3 to prevent incorrect insertion into the memory module slots.

Reverse this procedure to install a memory module. 

Description Spare part number

4096-MB (PC2-6400, 800-MHz, DDR2) 598855-001

2048-MB (PC2-6400, 800-MHz, DDR2) 598858-001

1024-MB (PC2-6400, 800-MHz, DDR2) 598861-001
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Removal and replacement procedures
Keyboard

Description Spare part number

For use in Belgium 501493-A41

For use in Brazil 501493-201

For use the Czech Republic 501493-211

For use in Denmark 501493-081

For use in Finland and Sweden 501493-B71

For use in France 501493-051

For use in French Canada 501493-121

For use in Germany 501493-041

For use in Greece 501493-DJ1

For use in Hungary 501493-221

For use in Iceland 501493-DD1

For use in Israel 501493-BB1

For use in Italy 501493-061

For use in Japan 501493-291

For use in Latin America 501493-161

For use in the Netherlands 501493-B31

For use in Norway 501493-091

For use in Portugal 501493-131

For use in Russia 501493-251

For use in Saudi Arabia 501493-171

For use in Slovakia 501493-231

For use in South Korea 501493-AD1

For use in Spain 501493-071

For use in Switzerland 501493-BG1

For use in Taiwan 501493-AB1

For use in Thailand 501493-281
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Removal and replacement procedures
Before removing the keyboard, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the SIM (see “SIM” on page 4-9). 

6. Remove the hard drive cover (see “Hard drive” on page 4-10).

Remove the keyboard:

1. Remove the following:

1 Two Mylar screw covers. The screw covers detailed in this section are available in the Rubber Kit, spare part 
number RUB-001.

2 Six Torx T8M2.0×8.0 screws.
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Removal and replacement procedures
2. Turn the computer display-side up, with the front toward you.

3. Open the computer as far as possible.

4. Lift the rear edge of the keyboard 1 and slide it 2 back until the pointing stick cable is accessible.

5. Release the zero insertion force (ZIF) connector 3 to which the pointing stick cable is attached, and disconnect 
the pointing stick cable 4 from the system board.

6. Swing the top edge of the keyboard 1 up and forward until it rests upside down on the palm rest.

7. Release the ZIF connector 2 to which the keyboard cable is attached, and disconnect the keyboard cable 3 
from the system board.

8. Remove the keyboard.

Reverse this procedure to install the keyboard.
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Removal and replacement procedures
Hinge cover

✎ The hinge cover is included in the Plastics Kit, spare part number 501499-001.

Before removing the hinge cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

Remove the hinge cover:

1. Turn the computer upside down, with the rear panel toward you.

2. Remove the two Torx T8M2.0×5.0 screws that secure the hinge cover to the computer.

3. Turn the computer right-side up, with the rear panel toward you.

4. Raise the display to an upright position.

5. Remove the hinge cover by pulling it away from the computer.

Reverse this procedure to install the hinge cover.
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Removal and replacement procedures
Top cover

Before removing the top cover, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8).

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

Remove the top cover:

1. Turn the computer upside down, with the front toward you.

2. Remove the following:

1 One small Mylar screw cover. All Mylar screw covers detailed in this section are included in the Rubber Kit, 
spare part number RUB-001.

2 Three Torx T8M2.0×8.0 screws.

3 Two large Mylar screw covers. The screw covers detailed in this section are included in the Rubber Kit, spare 
part number RUB-001.

4 Two Torx T8M2.0×4.0 screws.

Description Spare part number

Top cover (includes LED board and cable and display alignment guides) 501502-001
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Removal and replacement procedures
3. Turn the computer right-side up, with the front toward you.

4. Open the computer as far as possible.

5. Release the ZIF connector 1 to which the TouchPad board cable is connected and disconnect the TouchPad 
board cable from the system board.

6. Release the ZIF connector 2 to which the LED board cable is connected and disconnect the LED board cable 
from the system board.

7. Remove the two Phillips PM2.0×5.0 screws 3 that secure the top cover to the computer.

8. Lift the front edge of the top cover 1 until it rests at an angle.

9. Remove the top cover by pulling it away from the computer 2 at an angle.

Reverse this procedure to install the top cover.
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Removal and replacement procedures
RTC battery

✎ Removing the RTC battery and leaving it uninstalled for 5 or more minutes causes all passwords and CMOS 
settings to be cleared. 

Before removing the RTC battery, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

Remove the RTC battery: 

1. Disconnect the RTC battery cable 1 from the system board.

2. Remove the RTC battery 2. The RTC battery is attached to the system board using two-sided tape.

Reverse this procedure to install the RTC battery. 

Description Spare part number 

RTC battery (includes double-sided tape) 482963-001
Maintenance and Service Guide 4–23



Removal and replacement procedures
Audio connector board

Before removing the audio connector board, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

Remove the audio connector board and cable:

1. Release the ZIF connector 1 to which the audio connector board cable is connected, and disconnect the audio 
connector board cable 2 from the system board. The audio connector board cable is included with the audio 
connector board and is also available in the Cables Kit, spare part number MCK-001.

2. Remove the Phillips PM2.0×5.0 screw 3 that secures the audio connector board to the base enclosure.

3. Remove the audio connector board and cable 4.

Reverse this procedure to install the audio connector board.

Description Spare part number

Audio connector board (includes cable) 507056-001
4–24 Maintenance and Service Guide



Removal and replacement procedures
Bluetooth module

Before removing the Bluetooth module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8).

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

f. Audio connector board (see “Audio connector board” on page 4-24)

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable 1 from the system board.

2. Remove the Bluetooth module cable from the clips 2 built into the base enclosure.

3. Remove the Phillips PM2.0×4.0 screw 3 that secures the Bluetooth module and bracket to the system board. 

4. Remove the module 4 and bracket from the base enclosure.

Reverse this procedure to install the Bluetooth module. 

Description Spare part number

Bluetooth module

✎ The Bluetooth module spare part kit does not include a Bluetooth module cable. The 
Bluetooth module cable is included in the Cables Kit, spare part number 501500-001.

483113-001
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Removal and replacement procedures
Speaker

Before removing the speaker, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

f. Audio connector board (see “Audio connector board” on page 4-24)

g. Bluetooth module (see “Bluetooth module” on page 4-25)

Remove the speaker:

1. Disconnect the speaker cable 1 from the system board.

2. Remove the speaker cable from the clips 2 built into the base enclosure.

3. Remove the Phillips PM2.0×5.0 screw 3 that attaches the speaker to the base enclosure.

4. Remove the speaker 4 from the base enclosure.

Reverse this procedure to install the speaker. 

Description Spare part number

Speaker 507057-001
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Removal and replacement procedures
Display assembly

✎ The display assembly spare part kit includes an ambient light sensor, fingerprint reader, logo, 2 microphones, 
nameplate, 2 WLAN antenna transceivers and cables, and 2 WWAN antenna transceivers and cables.

Before removing the display assembly, follow these steps: 

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system. 

2. Disconnect all external devices connected to the computer. 

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer. 

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

Description Spare part number

12.1-inch, WXGA LED display assembly with webcam and outdoor light 504172-001

12.1-inch, WXGA LED display assembly with webcam 504170-001

12.1-inch, WXGA LED display assembly with outdoor light 504171-001

12.1-inch, WXGA LED display assembly 504169-001
Maintenance and Service Guide 4–27



Removal and replacement procedures
Remove the display assembly:

1. Open the computer as far as possible.

2. Disconnect the following cables from the system board and remove the cables from the clips built into the 
system board shielding:

1 Fingerprint reader board cable

2 Webcam cable

3 Microphone cable

3. Remove the wireless antenna cables 4 from the opening in the system board and the clips built into the system 
board shielding.

4. Remove the two Phillips PM2.0×4.0 screws 1 that secure the display panel cable to the system board.

5. Disconnect the display panel cable 2 from the system board.

6. Remove the Phillips PM2.0×4.0 screw 3 that secures the display converter cable to the system board.

7. Disconnect the display converter cable 4 from the system board.
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Removal and replacement procedures
Ä
CAUTION: The display assembly will be unsupported when the following screws are removed. To prevent damage to the 
display assembly, support it before removing the screws.

8. Remove the four Phillips PM2.5×6.0 screws 1 that secure the display assembly to the computer. Be sure to 
hold the display before removing the last screw to prevent damage to the display.

9. Lift the display assembly 2 straight up and remove it.

Reverse this procedure to install the display assembly.
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Removal and replacement procedures
System board

✎ The system board spare part kit includes replacement thermal material.

Before removing the system board, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

f. Display assembly (see “Display assembly” on page 4-27)

When replacing the system board, be sure that the following components are removed from the defective system 
board and installed on the replacement system board:

■ SIM (see “SIM” on page 4-9)

■ WLAN module (see “WLAN module” on page 4-12)

■ WWAN module (see “WWAN module” on page 4-15)

■ Memory modules (see “Memory module” on page 4-16)

■ RTC battery (see “RTC battery” on page 4-23)

■ Fan/heat sink assembly (see “Fan/heat sink assembly” on page 4-34)

■ Modem module (see “Modem module” on page 4-36)

Description Spare part number

For use in all countries and regions except for Russia and the People’s Republic of China

■ Equipped with Intel Core2 Duo SL9600 2.13-GHz processor, 1066-MHz FSB, and 6-MB L2 cache 530589-001

■ Equipped with Intel Core2 Duo SL9400 1.86-GHz processor, 1066-MHz FSB, and 6-MB L2 cache 501483-001

■ Equipped with Intel Core2 Duo SL9300 1.60-GHz processor, 1066-MHz FSB, and 6-MB L2 cache 501482-001

■ Equipped with Intel Core2 Duo SU9400 1.40-GHz processor, 800-MHz FSB, and 3-MB L2 cache 530590-001

■ Equipped with Intel Core2 Duo SU9300 1.20-GHz processor, 800-MHz FSB, and 3-MB L2 cache 501481-001

For use in Russia and the People’s Republic of China

■ Equipped with Intel Core2 Duo SL9600 2.13-GHz processor, 1066-MHz FSB, and 6-MB L2 cache 598660-001

■ Equipped with Intel Core2 Duo SL9400 1.86-GHz processor, 1066-MHz FSB, and 6-MB L2 cache 510371-001

■ Equipped with Intel Core2 Duo SL9300 1.60-GHz processor, 1066-MHz FSB, and 6-MB L2 cache 510370-001

■ Equipped with Intel Core2 Duo SU9400 1.40-GHz processor, 800-MHz FSB, and 3-MB L2 cache 598661-001

■ Equipped with Intel Core2 Duo SU9300 1.20-GHz processor, 800-MHz FSB, and 3-MB L2 cache 510369-001
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Removal and replacement procedures
Remove the system board:

1. Turn the computer upside down, with the front toward you.

2. Remove the wireless module compartment shield from the base enclosure. The wireless module compartment 
shield is included in the Shield Kit, spare part number 501503-001.

3. Turn the computer right-side up, with the front toward you.

4. Press the ExpressCard slot bezel 1 to release it from the ExpressCard slot. (The ExpressCard slot bezel is 
partially ejected from the ExpressCard slot.)

5. Remove the ExpressCard slot bezel 2. The ExpressCard slot bezel is included in the Plastics Kit, spare part 
number 501499-001.
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Removal and replacement procedures
6. Position the computer with the front toward you.

7. Remove the system board shield. The system board shield is included in the Shield Kit, spare part number 
501503-001.

8. Remove the four Phillips PM2.0×5.0 screws that secure the system board to the base enclosure.
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Removal and replacement procedures
9. Position the computer with the rear panel toward you.

10. Use the battery connector 1 to lift the front edge of the system board 2 until it rests at an angle.

11. Remove the system board by sliding it away from the base enclosure 3 at an angle.

Reverse this procedure to install the system board.
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Removal and replacement procedures
Fan/heat sink assembly

Before removing the fan/heat sink assembly, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

f. Display assembly (see “Display assembly” on page 4-27)

g. System board (see “System board” on page 4-30)

Remove the fan/heat sink assembly:

1. Disconnect the fan cable from the system board.

Description Spare part number

Fan/heat sink assembly (includes replacement thermal material) 501495-001
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Removal and replacement procedures
2. Turn the system board upside down with the front toward you.

3. Loosen the six Phillips PM2.5×7.0 captive screws 1 that secure the fan/heat sink assembly to the base 
enclosure in the 1, 2, 3, 4, 5, 6 sequence stamped into the fan/heat sink assembly.

4. Remove the fan/heat sink assembly 2.

✎ Due to the adhesive quality of the thermal material located between the processor heat sink and system board 
components, it may be necessary to move the processor heat sink from side to side to detach it.

✎ The thermal material must be thoroughly cleaned from the surfaces of the heat sink 1, 2, and 3, the processor 4, 
the graphics system component 5, and the system board component 6 each time the heat sink is removed. 
Replacement thermal material is included with all system board and fan/heat sink assembly spare part kits.

Reverse this procedure to install the fan/heat sink assembly.

✎ To properly ventilate the computer, allow at least a 7.6-cm (3-inch) clearance on the left side of the computer. The 
computer uses an electric fan for ventilation. The fan is controlled by a temperature sensor and is designed to turn 
on automatically when high temperature conditions exist. These conditions are affected by high external 
temperatures, system power consumption, power management/battery conservation configurations, battery fast 
charging, and software requirements. Exhaust air is displaced through the ventilation grill located on the left side 
of the computer.
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Removal and replacement procedures
Modem module

✎ The modem module spare part kit includes a modem module cable.

Before removing the modem module, follow these steps:

1. Shut down the computer. If you are unsure whether the computer is off or in Hibernation, turn the computer on, 
and then shut it down through the operating system.

2. Disconnect all external devices connected to the computer.

3. Disconnect the power from the computer by first unplugging the power cord from the AC outlet and then 
unplugging the AC adapter from the computer.

4. Remove the battery (see “Battery” on page 4-8). 

5. Remove the following components:

a. SIM (see “SIM” on page 4-9)

b. Hard drive cover (see “Hard drive” on page 4-10)

c. Keyboard (see “Keyboard” on page 4-17)

d. Hinge cover (see “Hinge cover” on page 4-20)

e. Top cover (see “Top cover” on page 4-21)

f. Display assembly (see “Display assembly” on page 4-27)

g. System board (see “System board” on page 4-30)

Remove the modem module:

1. Turn the system board upside down, with the RJ-11 and RJ-45 jacks toward you.

2. Remove the two Phillips PM2.5×4.0 screws 1 that secure the modem module to the system board.

3. Lift the modem module 2 straight up to disconnect it from the system board.

4. Disconnect the modem module cable 3 from the modem module.

5. Remove the modem module.

Reverse this procedure to install the modem module.

Description Spare part number 

For use only in Australia and New Zealand 461750-011

For use in all countries and regions except Australia and New Zealand 461750-001
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5
Computer Setup

Starting Computer Setup

Computer Setup is a preinstalled, ROM-based utility that can be used even when the operating system is not 
working or will not load.

✎ Some of the Computer Setup menu items listed in this guide may not be supported by your computer.

✎ An external keyboard or mouse connected to a USB port can be used with Computer Setup only if USB legacy 
support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 
displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.
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Computer Setup
Using Computer Setup

Navigating and selecting in Computer Setup

The information and settings in Computer Setup are accessed from the File, Security, Diagnostics, and System 
Configuration menus.

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 
displayed at the bottom of the screen.

❏ To select a menu or a menu item, use the keyboard arrow keys and then press enter, or use a pointing device 
to click the item.

❏ To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the screen.

❏ To close open dialog boxes and return to the main Computer Setup screen, press esc, and then follow the 
on-screen instructions.

✎You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or the keyboard to navigate 
and make selections in Computer Setup.

2. Press f10 to enter BIOS Setup.

3. Select the File, Security, Diagnostics, or System Configuration menu.

To exit Computer Setup menus, choose one of the following methods:

■ To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

■ Use the arrow keys to select File > Ignore changes and exit, and then press enter.

– or –

■ To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner of the 
screen, and then follow the on-screen instructions.

– or –

■ Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.
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Computer Setup
Restoring factory settings in Computer Setup

✎ Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 
displayed at the bottom of the screen.

2. Press f10 to enter BIOS Setup.

3. Use a pointing device or the arrow keys to select File > Restore defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then follow the 
on-screen instructions.

– or –

Use the arrow keys to select File > Save changes and exit, and then press enter.

Your changes go into effect when the computer restarts.

✎ Your password settings and security settings are not changed when you restore the factory settings.

Computer Setup menus

The menu tables in this section provide an overview of Computer Setup options. 

✎ Some of the Computer Setup menu items listed in this chapter may not be supported by your computer. 

File menu

Select To do this

System Information ■ View identification information for the computer and the batteries in 
the system.

■ View specification information for the processor, cache and memory size, 
system ROM, video revision, and keyboard controller version.

Set System Date and Time Set or change the date and time on the computer.

Restore defaults Replace the configuration settings in Computer Setup with the original factory 
settings. (Hard drive mode, password settings, and security settings are not 
changed when you restore the factory settings.)

Ignore changes and exit Cancel any changes entered during the current session. Then exit and restart 
the computer.

Save changes and exit Save any changes entered during the current session. Then exit and restart the 
computer. Your changes go into effect when the computer restarts.
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Computer Setup
Security menu

✎ Some of the menu items listed in this section may not be supported by your computer.

Select To do this

User Management (requires an 
administrator password)

■ Create a new BIOS user account.

■ View a list of ProtectTools users.

Password Policy (requires an 
administrator password)

Revise password policy criteria.

Allow HP SpareKey Enrollment Enable/disable permission to enroll or reset HP SpareKey.

HP SpareKey Enrollment Enroll or reset HP SpareKey, which is a set of security questions and answers 
used if you forget your password.

HP SpareKey Enable/disable HP SpareKey (enabled by default).

Fingerprint Reset on Reboot (If Present) Enable/disable the fingerprint reader (select models only; disabled by default).

Change Password Enter, change, or delete a BIOS administrator password.

DriveLock Passwords ■ Enable/disable DriveLock on any computer hard drive (enabled by default).

■ Change a DriveLock user password or master password.

✎ DriveLock settings are accessible only when you enter Computer Setup 
by turning on (not restarting) the computer.

Automatic DriveLock Enable/disable Automatic DriveLock support.

TPM Embedded Security (requires an 
administrator password)

■ Change TPM (Trusted Platform Module) Embedded Security device state at 
restart. The following options are available:

❐ Do Nothing (enabled by default)
❐ Available and Disabled

❐ Available and Enabled

❐ Factory Defaults
■ Reset Authentication Credential.

■ Enable/disable support for the following:

❐ Power-on authentication support (enabled by default)

❐ Operating system TPM management (enabled by default)

❐ Reset of TPM from operating system (disabled by default)

Disk Sanitizer Run Disk Sanitizer to destroy all existing data on the primary hard drive or the 
drive in the upgrade bay.

Ä If you run Disk Sanitizer, the data on the selected drive is 
destroyed permanently.

System IDs Enter a user-defined computer asset tracking number and ownership tag.

Setup BIOS Administrator Password Set up a BIOS administrator password.

Always Prompt for HP SpareKey Enrollment Enable/disable a prompt for HP SpareKey enrollment.
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Computer Setup
Diagnostics menu

System Configuration menu

✎ Some of the listed System Configuration options may not be supported by your computer.

Select To do this 

System Diagnostics menu ■ F1 System Information–Displays the following information:

❐ Identification information for the computer and the batteries in the 
system.

❐ Specification information for the processor, cache and memory size, 
system ROM, video revision, and keyboard controller version.

■ F2 Start-up Test–Verifies the system components needed for starting 
the computer.

■ F3 Run-In Test–Runs a comprehensive check on system memory.

■ F4 Hard Disk Test–Runs a comprehensive self-test on any hard drive in 
the system.

Select To do this 

Language Change the Computer Setup language.

Boot Options ■ Set a Startup Menu delay (in seconds). 

■ Enable/disable Custom Logo (disabled by default).

■ Enable/disable Display Diagnostic URL (enabled by default).

■ Enable/disable CD-ROM boot (enabled by default).

■ Enable/disable SD Card boot (enabled by default).

■ Enable/disable floppy boot (enabled by default).

■ Enable/disable PXE Internal NIC boot (enabled by default).

■ Set the Express Boot Popup delay in seconds.

■ Set the boot order.

(Continued)
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Computer Setup
Device Configurations ■ Enable/disable USB legacy support (enabled by default). When enabled, 
USB legacy support allows the following: 

❐ Use of a USB keyboard in Computer Setup even when a Windows® 
operating system is not running.

❐ Startup from bootable USB devices, including a hard drive, diskette 
drive, or optical drive connected by a USB port to the computer.

■ Select a parallel port mode: ECP (Enhanced Capabilities Port), standard, 
bidirectional, or EPP (Enhanced Parallel Port).

■ Enable/disable fan always on while connected to an AC outlet (enabled 
by default).

■ Enable/disable LAN Power Save (select models only). When enabled, saves 
power by turning off the LAN when not in use (enabled by default).

■ Enable/disable Data Execution Prevention. When enabled, the processor can 
disable some virus code execution, which helps to improve computer security.

■ SATA (Serial Advanced Technology Attachment) device mode. The following 
options are available:

❐ AHCI (Advanced Host Controller Interface)
❐ IDE (Integrated Drive Electronics)

❐ RAID (select models only)

✎ Availability of the options above varies by computer model.

■ Enable/disable secondary battery fast charge (enabled by default).

■ Enable/disable HP QuickLook 2 (enabled by default).

■ Enable/disable Virtualization Technology (select models only; disabled 
by default).

■ Enable/disable TXT (Intel® Trusted Execution Technology) (select models 
only; disabled by default).

■ Enable/disable Dual Core CPU (select models only; enabled by default).

■ Enable/Disable Unified Extensible Firmware Interface (UEFI) mode (disabled 
by default).

Built-In Device Options ■ Enable/disable the wireless switch (enabled by default).

■ Enable/disable embedded WWAN device radio (select models only; enabled 
by default).

■ Enable/disable embedded Bluetooth device radio (enabled by default).

■ Enable/disable the Network Interface Controller (LAN) (enabled by default).

■ Set the wake on LAN state. Options include the following:

❐ Disabled

❐ Boot to Network (set by default)

❐ Follow Boot Order
■ Enable/disable the fingerprint device (enabled by default).

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the embedded WLAN device (enabled by default).

■ Enable/disable LAN/WLAN switching (disabled by default).

■ Enable the ambient light sensor (enabled by default).

■ Enable/disable the Notebook Multibay device (enabled by default).

■ Enable/disable the integrated camera (select models only; enabled 
by default).

(Continued)

Select To do this 
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Computer Setup
Device Configurations ■ Enable/disable USB legacy support (enabled by default). When enabled, 
USB legacy support allows the following: 

❐ Use of a USB keyboard in Computer Setup even when a Windows® 
operating system is not running.

❐ Startup from bootable USB devices, including a hard drive, diskette 
drive, or optical drive connected by a USB port to the computer.

■ Select a parallel port mode: ECP (Enhanced Capabilities Port), standard, 
bidirectional, or EPP (Enhanced Parallel Port).

■ Enable/disable fan always on while connected to an AC outlet (enabled 
by default).

■ Enable/disable LAN Power Save (select models only). When enabled, saves 
power by turning off the LAN when not in use (enabled by default).

■ Enable/disable Data Execution Prevention. When enabled, the processor can 
disable some virus code execution, which helps to improve computer security.

■ SATA (Serial Advanced Technology Attachment) device mode. The following 
options are available:

❐ AHCI (Advanced Host Controller Interface)
❐ IDE (Integrated Drive Electronics)

❐ RAID (select models only)

✎ Availability of the options above varies by computer model.

■ Enable/disable secondary battery fast charge (enabled by default).

■ Enable/disable HP QuickLook 2 (enabled by default).

■ Enable/disable Virtualization Technology (select models only; disabled 
by default).

■ Enable/disable TXT (Intel® Trusted Execution Technology) (select models 
only; disabled by default).

■ Enable/disable Dual Core CPU (select models only; enabled by default).

■ Enable/Disable Unified Extensible Firmware Interface (UEFI) mode (disabled 
by default).

Built-In Device Options ■ Enable/disable the wireless switch (enabled by default).

■ Enable/disable embedded WWAN device radio (select models only; enabled 
by default).

■ Enable/disable embedded Bluetooth device radio (enabled by default).

■ Enable/disable the Network Interface Controller (LAN) (enabled by default).

■ Set the wake on LAN state. Options include the following:

❐ Disabled

❐ Boot to Network (set by default)

❐ Follow Boot Order
■ Enable/disable the fingerprint device (enabled by default).

■ Enable/disable a modem device (enabled by default).

■ Enable/disable the embedded WLAN device (enabled by default).

■ Enable/disable LAN/WLAN switching (disabled by default).

■ Enable the ambient light sensor (enabled by default).

■ Enable/disable the Notebook Multibay device (enabled by default).

■ Enable/disable the integrated camera (select models only; enabled 
by default).

(Continued)
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Computer Setup
Port Options (all are enabled by default) ✎ All port options are enabled by default.

■ Enable/disable the Smart Card slot.

■ Enable/disable the ExpressCard slot.

■ Enable/disable the serial port.

■ Enable/disable the parallel port.

■ Enable/disable the flash media reader.

■ Enable/disable the USB port.

Ä Disabling the USB port also disables MultiBay devices and ExpressCard 
devices on the advanced port replicator.

■ Enable/disable the 1394 port.

AMT Options (all are disabled by default) ✎ All AMT options are disabled by default.

■ Enable/disable Firmware Verbosity.

■ Enable/disable AMT Setup Prompt (CTRL-P).

■ Enable/disable USB Key Provisioning Support.

■ Enable/disable Unconfigure AMT on Next Boot.

■ Enable/disable Terminal Emulation Mode.

■ Enable/disable Firmware Progress Event Support.

■ Enable/disable Include TYPE-131 in SMBIOS.

Set Security Level Change, view, or hide security levels for all BIOS menu items.

Restore Security Defaults Restore the default security settings.

Select To do this 
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6
Specifications

Computer specifications 

Metric U.S.

Dimensions

Length 21.2 cm 8.35 in

Width 29.0 cm 11.42 in

Height 2.8 cm 1.10 in

Weight 1.70 kg 3.74 lb

Input power

Operating voltage 19.0 V dc @ 4.74 A - 65 W

Operating current 4.74 A

Temperature

Operating (not writing to optical disc) 0°C to 35°C 32°F to 95°F 

Operating (writing to optical disc) 5°C to 35°C 41°F to 95°F 

Nonoperating -20°C to 60°C -4°F to 140°F 

Relative humidity

Operating 10% to 90% 

Nonoperating 5% to 95% 

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

Shock

Operating 125 g, 2 ms, half-sine

Nonoperating 200 g, 2 ms, half-sine

Random vibration

Operating  0.75 g zero-to-peak, 10 Hz to 500 Hz, 0.25 oct/min sweep rate

Nonoperating 1.50 g zero-to-peak, 10 Hz to 500 Hz, 0.5 oct/min sweep rate

✎ Applicable product safety standards specify thermal limits for plastic surfaces. The computer operates well within this 
range of temperatures.
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Specifications
12.1-inch, WXGA display specifications

Hard drive specifications

Metric U.S.

Dimensions

Height 16.9 cm 6.7 in

Width 26.2 cm 10.3 in

Diagonal 30.8 cm 12.1 in

Number of colors Up to 16.8 million

Contrast ratio 250:1 (typical)

Brightness 180 nits (typical)

Pixel resolution

Pitch 0.279 × 0.279 mm

Format 1280 × 800

Configuration RGB vertical stripe

Backlight Edge lit

Character display 80 × 25

Total power consumption 4.0 W

Viewing angle +/-40° horizontal, +120/-40° vertical (typical)

250-GB* 160-GB* 120-GB* 80-GB* 

Dimensions

Height 8.0 mm 8.0 mm 8.0 mm 8.0 mm

Width 45.7 mm 45.7 mm 45.7 mm 45.7 mm

Weight 101 g 101 g 101 g 101 g

Interface type SATA SATA SATA SATA

Transfer rate 100 MB/sec 100 MB/sec 100 MB/sec 100 MB/sec

Security ATA security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 1.5 ms 1.5 ms 3 ms 3 ms

Average 12 ms 12 ms 13 ms 13 ms

Maximum 21 ms 21 ms 24 ms 24 ms

Logical blocks 488,397,168 312,581,808 234,456,960 156,304,640

Disc rotational speed 5400 rpm 5400 rpm 5400 rpm 5400 rpm

Operating temperature 5°C to 55°C (41°F to 131°F)

*1 GB = 1 billion bytes when referring to hard drive storage 
capacity. Actual accessible capacity is less. Actual drive 
specifications may differ slightly. 

✎ Certain restrictions and exclusions apply. Contact 
technical support for details. 
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Specifications
System DMA specifications

System interrupt specifications

Hardware DMA System function 

DMA0 Not applicable 

DMA1* Not applicable 

DMA2* Not applicable 

DMA3 Not applicable 

DMA4 Direct memory access controller 

DMA5* Not applicable 

DMA6 Not assigned 

DMA7 Not assigned 

*PC Card controller can use DMA 1, 2, or 5. 

Hardware IRQ System function 

IRQ0 System timer 

IRQ1 Standard 101-/102-Key or Microsoft® Natural Keyboard 

IRQ8 System CMOS/real-time clock 

IRQ12 Synaptics PS/2 TouchPad 

IRQ13 Numeric data processor 

IRQ16 Intel® ICH9 Family USB universal Host Controller 2937
Mobile Intel 4 Series Express Chipset Family

IRQ17 High Definition Audio Controller
Intel® ICH9 Family USB universal Host Controller 2938 
Marvel Yukon 88E8072 PCIE-Gigabit Ethernet Controller

IRQ18 Intel® ICH9 Family USB universal Host Controller 2939
Intel® ICH9 Family USB universal Host Controller 2936

IRQ19  Intel® ICH9 Family USB2 Enhanced Controller 293C

IRQ20 Intel® ICH9 Family USB2 Enhanced Controller 293A
Intel® ICH9 Family USB universal Host Controller 2934

IRQ21 Intel® ICH9M-E/M SATA AHCI Controller

IRQ22 Intel® ICH9 Family USB universal Host Controller 2935

*Default configuration; audio possible configurations are IRQ5, IRQ7, IRQ9, IRQ10, or none. 

✎ PC Cards may assert IRQ3, IRQ4, IRQ5, IRQ7, IRQ9, IRQ10, IRQ11, or IRQ15. Either the infrared or the serial port 
may assert IRQ3 or IRQ4. 

✎ For operating systems after Windows 2000, APIC (Advanced programming interrupt controller) is used.
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Specifications
System I/O address specifications

I/O address (hex) System function (shipping configuration) 

000 - 01F DMA controller

020 - 021 Program interrupt controller

024 - 025 Program interrupt Controller

028 - 029 Program interrupt Controller

02C - 03D Program interrupt Controller

02E - 02F  Motherboard Resource

030 - 031 Program interrupt Controller

034 - 035 Program interrupt Controller

038 - 039 Program interrupt Controller

03C- 03D Program interrupt Controller

040 - 043 System Timer 

04E-04F Motherboard Resource

050-053 System Timer

060 Standard 101-/102-Key or Microsoft. Natural Keyboard

061 Motherboard Resource

062 Microsoft ACPI-Compliant Embedded Controller

063 Motherboard Resource

064 Standard 101-/102-Key or Microsoft. Natural Keyboard 

065 Motherboard resources

066 Microsoft ACPI-Compliant Embedded Controller

067 Motherboard resources

070 Motherboard resources

070-077 System CMOS/real time clock

080 Motherboard resources

081-091 Direct memory access controller

092 Motherboard resources

093-09F Direct memory access controller

0A0-0A1 Program interrupt Controller

0A4-0A5 Program interrupt Controller

0A8-0A9 Program interrupt Controller

0AC-0AD Program interrupt Controller

0B0-0B1 Program interrupt Controller

0B2-0B3 Motherboard resources

0B4- 0B5 Program interrupt Controller

0B8-0B9 Program interrupt Controller

0BC- 0BD Program interrupt Controller

(Continued)
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Specifications
0C0- 0DF Direct memory access controller

0F0- 0F0 Numeric data processor

0200-027F Motherboard resource

3B0-3BB Mobile Intel 4 series Express Chipset Family

3C0-3DF Mobile Intel 4 series Express Chipset Family

400-47F Motherboard resource

4D0-4D1 Programmable interrupt controller

500-57F Motherboard resources

1000-1003 Motherboard resources

1010-101F Motherboard resources

2000-20FF Marvell Yukon 88E8072 PCI-E Gigabit Ethernet Controller

2000-2FFF ICH9 Family PCI Express Root Port6-294A

3000-4FFF ICH9 Family PCI Express Root Port5-2948

5000-6FFF ICH9 Family PCI Express Root Port3-2944

7000-701F ICH9M-E/M SATA AHCI Controller

7020-703F ICH9 Family USB universal Host Controller-2936

7040-705F ICH9 Family USB universal Host Controller-2935

7060-707F ICH9 Family USB universal Host Controller-2934

7080-709F  ICH9 Family USB universal Host Controller-2939

70A0-70BF ICH9 Family USB universal Host Controller-2938

70C0-70DF ICH9 Family USB universal Host Controller-2937

70E0-70E7 ICH9M-E/M SATA AHCI Controller

70E8-70EF ICH9M-E/M SATA AHCI Controller

70F0-70F7 Mobile Intel 4 series Express Chipset Family

70F8-70FB ICH9M-E/M SATA AHCI Controller

70FC-70FF ICH9M-E/M SATA AHCI Controller

EF80-EF9F Motherboard resources

FE00-FE0F Motherboard resources

FE80-EF8F Motherboard resources

FFFF Motherboard resources

I/O address (hex) System function (shipping configuration) 
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Specifications
System memory map specifications

Size Memory address System function

640 KB 00000000-0009FFFF Base memory

128 KB 000A0000-000BFFFF Video memory

64 KB 000C0000-000CFFFF Video BIOS

64 KB 000E8000-000FFFFF System BIOS

00100000- XFFFFFFF Extended memory (based on memory 
installed)

(X+1)0000000-FEDFFFFF PCI bus

FED00000-FED003FF High precision event timer

FEE01000-FFFFFFFF PCI bus
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7
Screw listing

This section provides specification and reference information for the screws used in the computer. Some screws 
listed in this section are available in the Screw Kit, spare part number 501498-001.

Phillips PM2.0×5.0 captive screw

Where used: 6 captive screws that secure the hard drive cover to the computer (screws are secured by C clips)

Color Quantity Length Thread Head diameter 

Black 6 5.0 mm 2.0 mm 5.0 mm 
Maintenance and Service Guide 7–1



Screw listing
Phillips PM2.0×3.0 screw

 

Where used: 2 screws that secure the hard drive bracket to the system board

Color Quantity Length Thread Head diameter 

Silver 2 3.0 mm 2.0 mm 5.0 mm
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Screw listing
Phillips PM2.0×4.0 screw

 

Where used:

1 Two screws that secure the WLAN module to the system board

2 Two screws that secure the WWAN module to the system board

Where used: 2 screws that secure the modem module to the system board

Color Quantity Length Thread Head diameter

Black 6 4.0 mm 2.0 mm 5.0 mm
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Screw listing
Torx T8M2.0×8.0 screw

 

Where used: 6 screws that secure the keyboard to the computer

Where used: 3 screws that secure the top cover to the base enclosure

Color Quantity Length Thread Head diameter 

Black 9 8.0 mm 2.0 mm 4.5 mm
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Screw listing
Torx T8M2.0×5.0 screw

 

Where used: 2 screws that secure the hinge cover to the computer

Where used: 2 screws that secure the top cover to the base enclosure

Color Quantity Length Thread Head diameter

Black 4 5.0 mm 2.0 mm 4.5 mm
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Screw listing
Phillips PM2.0×5.0 screw

 

Where used: 2 screws that secure the top cover to the base enclosure

Where used: One screw that secures the audio connector board to the base enclosure

Color Quantity Length Thread Head diameter

Black 8 5.0 mm 2.0 mm 5.0 mm
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Screw listing
Where used: One screw that secures the speaker to the base enclosure

Where used: 4 screws that secure the system board to the base enclosure
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Screw listing
Phillips PM2.0×4.0 screw

Where used: One screw that secures the Bluetooth module to the base enclosure

Where used:

1 One screw that secures the display converter cable to the system board

2 Two screws that secure the display panel cable to the system board

Color Quantity Length Thread Head diameter 

Black 4 4.0 mm 2.0 mm 4.0 mm
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Screw listing
Torx T8M2.5×6.0 screw

 

Where used: 4 screws that secure the display assembly to the computer

Color Quantity Length Thread Head diameter 

Black 4 6.0 mm 2.5 mm 5.0 mm
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Screw listing
Phillips PM2.5×7.0 captive screw

 

Where used: 6 captive screws that secure the fan/heat sink assembly to the system board (screws are secured by 
C clips)

Color Quantity Length Thread Head diameter 

Silver 6 7.0 mm 2.5 mm 5.0 mm
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8
Backup and recovery

Backup and recovery in Windows Vista

Overview

To protect your information, use the Backup and Restore Center to back up individual files and folders, back up 
your entire hard drive (select models only), or create system restore points. In case of system failure, you can use 
the backup files to restore the contents of your computer.

The Backup and Restore Center provides the following options:

■ Backing up individual files and folders

■ Backing up the entire hard drive (select models only)

■ Scheduling automatic backups (select models only)

■ Creating system restore points

■ Recovering individual files

■ Restoring the computer to a previous state

■ Recovering information using recovery tools

✎ For detailed instructions, perform a search for these topics in Help and Support.

✎ In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

■ Store personal files in the Documents folder, and back it up regularly.

■ Back up templates that are stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time-saver if you have to reset your preferences.
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To create a screen shot:

1. Display the screen you want to save.

2. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

3. Open a word-processing document, and then select Edit > Paste.

The screen image is added to the document.

4. Save the document.

■ When backing up to discs, use any of the following types of discs (purchased separately): CD-R, CD-RW, 
DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD}RW. The discs you use will depend on the type of optical 
drive installed in your computer.

✎ DVDs and DVDs with double-layer (DL) support store more information than CDs, so using them for backup 
reduces the number of recovery discs required.

■ When backing up to discs, number each disc before inserting it into the optical drive of the computer.

To create a backup using Backup and Restore Center, follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

✎ The backup process may take over an hour, depending on file size and the speed of the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to back up your entire computer (select models only) or your files.

✎Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools: You can use the Backup and Restore Center to recover information you have 
previously backed up. You can also use Windows Startup Repair to fix problems that might prevent Windows 
from starting correctly.

■ f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image. The image 
includes the Windows operating system and software programs installed at the factory.

✎ If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. For additional information, refer to the Using a Windows 
Vista operating system DVD (purchased separately) section in this guide.
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Using the Windows recovery tools

To recover information you previously backed up, follow these steps:

1. Click Start > All Programs > Maintenance > Backup and Restore Center.

2. Follow the on-screen instructions to recover your entire computer (select models only) or your files.

✎Windows includes the User Account Control feature to improve the security of your computer. You may be 
prompted for your permission or password for tasks such as installing software, running utilities, or changing 
Windows settings. Refer to Help and Support for more information.

To recover your information using Startup Repair, follow these steps:

Ä
CAUTION: Using Startup Repair completely erases hard drive contents and reformats the hard drive. All files you have created 
and any software installed on the computer are permanently removed. When reformatting is complete, the recovery process 
restores the operating system, as well as the drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition and the HP Recovery partition. To find the 
partitions, select Start > Computer.

✎ If the Windows partition and the HP Recovery partition have been deleted, you must recover your operating 
system and programs using the Windows Vista operating system DVD and the Driver Recovery disc (both 
purchased separately). For additional information, refer to the Using a Windows Vista operating system DVD 
(purchased separately) section in this guide.

3. Restart the computer, and then press f8 before the Windows operating system loads.

4. Select Repair your computer.

5. Follow the on-screen instructions.

✎For additional information on recovering information using the Windows tools, perform a search for these topics in 
Help and Support.

Using f11

Ä
CAUTION: Using f11 completely erases hard drive contents and reformats the hard drive. All files you have created and any 
software installed on the computer are permanently removed. The f11 recovery tool reinstalls the operating system and HP 
programs and drivers that were installed at the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11, follow these steps:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition. To find the partition, select 
Start > Computer.

✎ If the HP Recovery partition has been deleted, you must recover your operating system and programs using the 
Windows Vista operating system DVD and the Driver Recovery disc (both purchased separately). For additional 
information, refer to the “Using a Windows Vista operating system DVD (purchased separately)” section in 
this guide.

3. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu” message is 
displayed at the bottom of the screen.

4. Press f11 while the “Press <F11> for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows Vista operating system DVD (purchased separately)

If you are unable to boot (start up) your computer, you must purchase a Windows Vista operating system DVD to 
reboot the computer and repair the operating system. Make sure that your most recent backup (stored on discs or on 
an external drive) is easily accessible. To order a Windows Vista operating system DVD, go to 
http://www.hp.com/support, select your country or region, and follow the on-screen instructions. You can also 
order the DVD by calling technical support. For contact information, refer to the Worldwide Telephone Numbers 
booklet included with the computer.

Ä
CAUTION: Using a Windows Vista operating system DVD completely erases hard drive contents and reformats the hard drive. 
All files you have created and any software installed on the computer are permanently removed. When reformatting is complete, 
the recovery process helps you restore the operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows Vista operating system DVD, follow these steps:

✎ This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows Vista operating system DVD into the optical drive before 
the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.
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Backup and recovery in Windows XP

Overview

To protect your information, use the Windows Backup utility (select models only) to back up files and folders or 
create recovery points. In case of system failure, you can use the backup files to restore your computer.

Windows provides the following options:

■ Backing up individual files and folders

■ Backing up all files and folders

■ Scheduling automatic backups

■ Creating recovery points

■ Recovering information

✎ For detailed instructions, perform a search for these topics in Help and Support.

✎ In case of system instability, HP recommends that you print the recovery procedures and save them for later use.

Backing up your information

Recovery after a system failure is as complete as your most current backup. You should create your initial backup 
immediately after software setup. As you add new software and data files, you should continue to back up your 
system on a regular basis to maintain a reasonably current backup.

You can back up individual files or folders to an optional external hard drive or to a network drive.

Note the following when backing up:

■ Store personal files in the My Documents folder, and back it up periodically.

■ Back up templates stored in their associated programs.

■ Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot of your settings. 
The screen shot can be a time saver if you have to reset your preferences.

To copy the screen and paste it into a word-processing document:

a. Display the screen you want to save.

b. Copy the screen image:

To copy only the active window, press alt+fn+prt sc.

To copy the entire screen, press fn+prt sc.

c. Open a word-processing document, click Edit > Paste.

The screen image is added to the document.

d. Save the document.
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To create a backup using the Windows Backup utility (select models only), follow these steps:

✎ Be sure that the computer is connected to AC power before you start the backup process.

✎ The backup process may take over an hour, depending on file size and the speed of the computer.

1. Click Start > All Programs > Accessories > System Tools > Backup.

2. Follow the on-screen instructions.

Performing a recovery

In case of system failure or instability, the computer provides the following tools to recover your files:

■ Windows recovery tools (select models only): You can use the Windows Backup utility to recover information 
you have previously backed up.

■ Operating System and Driver Recovery discs (included with your computer): You can use the discs to recover 
your operating system and programs installed at the factory.

Recovering your information

To recover information you previously backed up, follow these steps:

1. If possible, back up all personal files.

2. Click Start > All Programs > Accessories > System Tools > Backup.

The Backup or Restore Wizard opens.

3. Click Restore files and settings, and then click Next.

4. Follow the on-screen instructions.

✎ For additional information on initiating a recovery in Windows, perform a search for this topic in Help and 
Support.

Recovering the operating system and programs

Ä
CAUTION: The recovery process reformats and completely erases the hard drive. All files you have created and any software 
installed on the computer are permanently removed. The recovery process reinstalls the original operating system, software, and 
drivers. Software, drivers, and updates not installed by HP must be manually reinstalled.

To recover your operating system and programs, follow these steps:

1. If possible, back up all personal files. 

2. Insert the Operating System disc into the optical drive.

3. Shut down the computer.

4. Turn on the computer.

5. Follow the on-screen instructions to install the operating system.

6. After the operating system is installed, remove the Operating System disc and insert the Driver Recovery disc.

7. Follow the on-screen instructions to install the drivers and programs.
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Connector pin assignments

1394

 
Pin Signal

1 TPB-

2 TPB+

2 TPA-

4 TPA+
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Connector pin assignments
Audio-in (microphone)

 

Audio-out (headphone)

Pin Signal

1 Audio signal in

2 Audio signal in

3 Ground

Pin Signal

1 Audio out, left channel

2 Audio out, right channel

3 Ground
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Connector pin assignments
External monitor

 
Pin Signal

1 Red analog

2 Green analog

3 Blue analog

4 Not connected

5 Ground

6 Ground analog

7 Ground analog

8 Ground analog

9 +5 VDC

10 Ground

11 Monitor detect

12 DDC 2B data

13 Horizontal sync

14 Vertical sync

15 DDC 2B clock
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RJ-11 (modem)

Pin Signal

1 Unused

2 Tip

3 Ring

4 Unused

5 Unused

6 Unused
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Connector pin assignments
RJ-45 (network)

Pin Signal

1 Transmit +

2 Transmit -

3 Receive +

4 Unused

5 Unused

6 Receive -

7 Unused

8 Unused
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Connector pin assignments
Universal Serial Bus

 

Pin Signal

1 +5 VDC

2 Data

3 Data +

4 Ground
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Power cord set requirements

The wide range input feature of the computer permits it to operate from any line voltage from 100 to 120 volts AC 
or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the country or region 
where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or region where 
the computer is used.

Requirements for all countries and regions

The requirements listed below are applicable to all countries and regions:

■ The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

■ All power cord sets must be approved by an acceptable accredited agency responsible for evaluation in the 
country or region where the power cord set will be used.

■ The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage rating of 125 or 
250 V AC, as required by the power system of each country or region.

■ The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320 Standard Sheet C13 
connector for mating with the appliance inlet on the back of the computer.
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Power cord set requirements
Requirements for specific countries and regions

Country/region Accredited agency Applicable note number 

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark  DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China CCC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole grounding type 
with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the Japanese 
Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug must be a 
two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler and wall 
plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it will be used.
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Recycling

Battery

When a battery has reached the end of its useful life, do not dispose of the battery in general household waste. 
Follow the local laws and regulations in your area for computer battery disposal.

Display

Å
WARNING: The backlight contains mercury. Caution must be exercised when removing and handling the backlight to avoid 
damaging this component and causing exposure to the mercury.

Ä
CAUTION: The procedures in this chapter can result in damage to display components. The only components intended for 
recycling purposes are the liquid crystal display (LCD) panel and the backlight. When you remove these components, handle 
them carefully.

✎ Materials Disposal. This HP product contains mercury in the backlight in the display assembly that might 
require special handling at end-of-life. Disposal of mercury may be regulated because of environmental 
considerations. For disposal or recycling information, contact your local authorities, or see the Electronic 
Industries Alliance (EIA) Web site at http://www.eiae.org.

This section provides disassembly instructions for the display assembly. The display assembly must be 
disassembled to gain access to the backlight 1 and the liquid crystal display (LCD) panel 2.

✎ The procedures provided in this appendix are general disassembly instructions. Specific details, such as screw 
sizes, quantities, and locations, and component shapes and sizes, can vary from one computer model to another.
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Perform the following steps to disassemble the display assembly:

1. Remove all screw covers 1 and screws 2 that secure the display bezel to the display assembly.

2. Lift up and out on the left and right inside edges 1 and the top and bottom inside edges 2 of the display bezel 
until the bezel disengages from the display assembly.

3. Remove the display bezel 3.
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Recycling
4. Disconnect all display panel cables 1 from the display inverter and remove the inverter 2.

5. Remove all screws 1 that secure the display panel assembly to the display enclosure.

6. Remove the display panel assembly 2 from the display enclosure.

7. Turn the display panel assembly upside down.

8. Remove all screws that secure the display panel frame to the display panel.
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Recycling
9. Use a sharp-edged tool to cut the tape 1 that secures the sides of the display panel to the display panel frame.

10. Remove the display panel frame 2 from the display panel.
 

11. Remove the screws 1 that secure the backlight cover to the display panel.

12. Lift the top edge of the backlight cover 2 and swing it outward.

13. Remove the backlight cover.

14. Turn the display panel right-side up.

15. Remove the backlight cables 1 from the clip 2 in the display panel.
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16. Turn the display panel upside down.

17. Remove the backlight frame from the display panel.

Å
WARNING: The backlight contains mercury. Exercise caution when removing and handling the backlight to avoid damaging 
this component and causing exposure to the mercury.

18. Remove the backlight from the backlight frame.
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Recycling
19. Disconnect the display cable 1 from the LCD panel.

20. Remove the screws 2 that secure the LCD panel to the display rear panel.

21. Release the LCD panel 3 from the display rear panel.

22. Release the tape 4 that secures the LCD panel to the display rear panel.

23. Remove the LCD panel.

24. Recycle the LCD panel and backlight.
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connector pinout 9–1
enabling/disabling 5–8
location 2–8

A
AC adapter, spare part number 3–10, 3–11, 3–14, 3–15
accessory battery connector 2–12
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allow HP SpareKey enrollment 5–4
ambient light sensor

enabling/disabling 5–6, 5–7
location 2–2

AMT Options 5–8
AMT Setup Prompt 5–8
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antenna components 2–1
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removal 4–24
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location 2–8

audio-out jack
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automatic DriveLock 5–4

B
backing up files and folders 8–1, 8–5
backing up your information 8–1
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C
Cable Kit
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Maintenance and Service Guide Index–1



Index
computer model description 3–1, 4–6
computer part number 3–1, 4–6
computer product name 3–1, 4–6
computer serial number 3–1, 4–6
Computer Setup

boot options 5–5
built-in device options 5–6, 5–7
device configuration 5–6, 5–7
diagnostics menu 5–5
file menu 5–3
language 5–5
menu 5–3
navigating 5–2
overview 5–1
port options 5–8
restore security defaults 5–8
restoring factory settings 5–3
Security menu 5–4
selecting 5–2
set security level 5–8
starting 5–1
system configuration menu 5–5
using 5–2

computer warranty period 3–1, 4–6
connector pinout

1394 port 9–1
audio-in jack 9–2
audio-out jack 9–2
external monitor port 9–3
headphone jack 9–2
microphone jack 9–2
modem jack 9–4
monitor port 9–3
network jack 9–5
RJ-11 jack 9–4
RJ-45 jack 9–5
USB port 9–6

connectors, service considerations 4–1
convertible hinge 2–2
ctrl+alt+del button 2–11

D
diagnostics menu 5–5
discs

Driver Recovery 8–6
Operating System 8–6

disk sanitizer 5–4
display assembly

removal 4–27
spare part numbers 3–3, 3–14, 4–27

display components
illustrated 2–2
recycling 11–1

display inverter, removal 11–3
display release latch 2–7
display switch 2–3
docking connector 2–12
drive light 2–5
DriveLock passwords 5–4
Driver Recovery disc 8–6

E
electrostatic discharge 4–2
equipment guidelines 4–4
Esc button 2–11
esc key 2–4
ExpressCard slot

enabling/disabling 5–8
location 2–9

ExpressCard slot bezel
illustrated 3–9
removal 4–31

external monitor port
connector pinout 9–3
location 2–11

external WWAN antenna button 2–7

F
F1 System Information 5–5
F2 Start-up Test 5–5
F3 Run-In Test 5–5
F4 Hard Disk Test 5–5
fan/heat sink assembly

removal 4–34
spare part number 3–4, 3–13, 4–34

feet
locations 4–7
spare part number 3–4, 3–13

file menu 5–3
files and folders

backing up 8–1, 8–5
recovering 8–1

fingerprint reader
enabling/disabling 5–6, 5–7
location 2–2, 2–8

fingerprint reset on reboot 5–4
Firmware Progress Event Support 5–8
Firmware Verbosity 5–8
flash media reader, enabling/disabling 5–8
fn key 2–4, 2–6
front components 2–7
function keys 2–4

G
grounding guidelines 4–2
guidelines

equipment 4–4
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hard drive
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precautions 4–2
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spare part numbers 3–6, 3–8, 3–12, 3–13, 3–14, 

4–10
hard drive bay 2–12
hard drive bracket, removal 4–11
hard drive connector cable

disconnection 4–11
spare part number 3–6, 3–8, 3–14, 4–10

hard drive cover
illustrated 3–9
removal 4–10

headphone jack
connector pinout 9–2
location 2–8

hinge cover
illustrated 3–9
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HP Docking Station
spare part number 3–10, 3–11
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HP SpareKey 5–4
HP SpareKey enrollment 5–4

I
illustrated parts catalog 3–1
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audio-out 2–8
headphone 2–8
microphone 2–8
modem 2–11
network 2–11
RJ-11 2–11
RJ-45 2–11

jog dial 2–11

K
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keyboard
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L
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N
network jack
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set requirements 10–1
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transporting guidelines 4–3

U
Unconfigure AMT on Next Boot 5–8
Universal Serial Bus (USB) port

connector pinout 9–6
enabling/disabling 5–8
location 2–8, 2–9, 2–10

unknown password 4–5
USB Key Provisioning Support 5–8
user management 5–4

V
vent 2–9, 2–10, 2–12
volume down light 2–5
volume mute button 2–3
volume mute light 2–5
volume scroll zone 2–3
volume up light 2–5

W
webcam

enabling/disabling 5–6, 5–7
location 2–2

webcam light 2–2
Windows applications key 2–4
Windows Backup utility 8–6
Windows logo key 2–4
Windows recovery 8–6
wireless antenna components 2–1
wireless light 2–9, 2–10
wireless switch

enabling/disabling 5–6, 5–7
location 2–9, 2–10

WLAN antenna 2–1
WLAN module

enabling/disabling 5–6, 5–7
removal 4–12
spare part numbers 3–5, 3–6, 3–11, 3–12, 3–14, 

4–12, 4–13
workstation guidelines 4–4
WWAN antenna 2–1
WWAN module

enabling/disabling 5–6, 5–7
removal 4–15
spare part number 3–6, 3–11, 4–15
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